ASSESSING QUAKING ASPEN (*POPULUS TREMULOIDES*) DECLINE ON CEDAR MOUNTAIN IN SOUTHERN UTAH USING REMOTE SENSING AND GEOGRAPHIC INFORMATION SYSTEMS.

by

Chad M. Oukrop

A thesis submitted in partial fulfillment of the requirement for the degree

of

MASTER OF SCIENCE

in

Ecology

Approved:

________________________  _______________________
Ronald J. Ryel           Dale L. Bartos
Major Professor          Committee Member

________________________  _______________________
R. Douglas Ramsey        Byron Burnham
Committee Member         Dean of Graduate Studies

UTAH STATE UNIVERSITY
Logan, Utah

2010
ABSTRACT

Assessing Quaking Aspen (Populus tremuloides) Decline on Cedar Mountain in Southern Utah Using Remote Sensing and Geographic Information Systems

by

Chad M. Oukrop, Master of Science
Utah State University, 2010

Quaking aspen (Populus tremuloides Michx.) is the most widespread deciduous tree species in North America and aspen ecosystems are highly valued for multiple use, being noted for forage production, understory diversity, wildlife habitat, timber, hydrological assets, and aesthetics. However, aspen communities in the Intermountain Region of the western United States are in evident decline, with certain areas experiencing rapid mortality over the past decade. One location of special interest is the quaking aspen on Cedar Mountain in Southern Utah, USA, an isolated population in the southwestern portion of aspen’s geographic range.

Lacking critical information on the location, extent, and magnitude of declining stands, land managers could utilize detailed spatial information to manage aspen on Cedar Mountain. To inform land managers of Cedar Mountain and develop methodologies applicable for aspen landscapes across the Intermountain West, a spatially
explicit aspen stand type classification using multi-spectral imagery, digital elevation models, and ancillary data was produced for the 27,216-ha pilot study area. In addition, a statistical analysis was performed to assess the relationships between landscape parameters derived from the geospatial information (i.e. slope, aspect, elevation) and aspen on the Cedar Mountain landscape.

A supervised classification composed of three aspen stand types (1-healthy, 2-damaged, 3-seral) was produced using Classification and Regression Tree (CART) analysis and validated using National Agriculture Imagery Program (NAIP) imagery. Within Cedar Mountain aspen cover, classification estimates were 49%, 35%, and 16% for healthy, damaged, and seral aspen stand types, respectively. Validation measures yielded an overall accuracy measure of 81.3%, (KHAT=.69, n = 446).

Important landscape metrics for the three health classes were found to be significantly different. Damaged stands were found primarily at lower elevations on south-to-west (drier) aspects. Within the aspen elevation range, the mean elevation of damaged stands (2,708 m) was significantly lower than that of the mean elevation of healthy stands (2,754 m). Aspect (moisture index) was also significantly different, with damaged stands primarily on southerly (drier) aspects and healthy stands generally on northerly (wetter) aspects. Slope, however, was not found to be significantly different among aspen types.
ACKNOWLEDGMENTS

Impartial to my skills as one to gather people, this work was otherwise impossible without the interdisciplinary and multiagency coordination of many thoughtful and helpful people. I would like to explicitly acknowledge the individual persons who provided expert and personal guidance throughout this project. First to thank are the members of my master’s thesis committee: Ron Ryel, Dale L. Bartos, and R. Douglas Ramsey. Throughout the course of my project, my major advisor, Ron Ryel, demonstrated amazing patience and guidance in the face of life-threatening adversity; an example of humility and honor that I will forever admire. Special thanks to Dale L. Bartos, whose charismatic nature ultimately made everyone’s participation reality, and for his personal guidance and example outside the professional field, and to R. Douglas Ramsey, who allowed me the freedom and time to innovate, while selectively imparting valuable information in his field of expertise that markedly guided my project.

Next, I would like to list and thank the individuals that I consider my colleagues in my efforts: Dave Evans, my closest academic peer for countless hours of cooperative work and companionship. His personality and scientific drive was always refreshing and inspiring. Alex Hernandez and Samuel Rivera from the Remote Sensing and Geographic Information System laboratory of Utah State University for their advice and guidance that made this project a reality. Patrick Moore of the Utah Department of Natural Resources, Chad Reid of the Utah State University Forestry Extension in Cedar City, UT, and Jim Bowns from Southern Utah University provided invaluable guidance and contact information for Cedar Mountain. Randy Hamilton and Haans Fisk of the Remote Sensing Application Center in Salt Lake City, UT, imparted their priceless technical
expertise. Special thanks to the Cedar Mountain Initiative, the USDA Forest Service, Rocky Mountain Research Station in Logan, UT, and the Utah State University Ecology Center for funding and support.

Chad M. Oukrop
# CONTENTS

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABSTRACT</td>
<td>........................................................................................................</td>
<td>iii</td>
</tr>
<tr>
<td>ACKNOWLEDGMENTS</td>
<td>.................................................................................................</td>
<td>v</td>
</tr>
<tr>
<td>LIST OF TABLES</td>
<td>..............................................................................................</td>
<td>ix</td>
</tr>
<tr>
<td>LIST OF FIGURES</td>
<td>...............................................................................................</td>
<td>xi</td>
</tr>
<tr>
<td>CHAPTER</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1. INTRODUCTION</td>
<td>Quaking aspen in western landscapes</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Goals and objectives</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Study area</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>References</td>
<td>8</td>
</tr>
<tr>
<td>2. LITERATURE REVIEW</td>
<td>Aspen ecology</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>Remote sensing/GIS modeling</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>References</td>
<td>32</td>
</tr>
<tr>
<td>3. MODERATE-SCALE MAPPING METHODS OF ASPEN STAND TYPES: A CASE STUDY FOR CEDAR MOUNTAIN IN SOUTHERN UTAH</td>
<td>43</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Abstract</td>
<td>43</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td>44</td>
</tr>
<tr>
<td></td>
<td>Methods</td>
<td>47</td>
</tr>
<tr>
<td></td>
<td>Results</td>
<td>53</td>
</tr>
<tr>
<td></td>
<td>Discussion</td>
<td>55</td>
</tr>
<tr>
<td></td>
<td>Conclusion</td>
<td>59</td>
</tr>
<tr>
<td></td>
<td>References</td>
<td>60</td>
</tr>
<tr>
<td>4. RAPID MORTALITY OF POPULUS TREMULOIDES ON CEDAR MOUNTAIN IN SOUTHERN UTAH</td>
<td>70</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Abstract</td>
<td>70</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td>71</td>
</tr>
<tr>
<td></td>
<td>Study area</td>
<td>74</td>
</tr>
</tbody>
</table>
Data ................................................................................................................................. 77
Validation ......................................................................................................................... 81
Results ............................................................................................................................... 82
Discussion ........................................................................................................................ 84
Conclusion ....................................................................................................................... 93
References ...................................................................................................................... 93

5. CONCLUSION ............................................................................................................. 106

APPENDICES .................................................................................................................. 108

Appendix A   Predictor Layer Preparation ................................................................. 109
Appendix B   Sampling ................................................................................................. 114
Appendix C   Modeling ................................................................................................. 119
Appendix D   Validation ............................................................................................... 123
# LIST OF TABLES

<table>
<thead>
<tr>
<th>Table</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1.</td>
<td>PRISM 2006 monthly and annual climatic data for Cedar Mountain, Utah (37.56248 N 113.0632 W) are given. Maximum (Tmax) and minimum (Tmin) temperature (Celsius), and precipitation (mm) were calculated for period from 1971 through 2000. The spatial resolution for this data set was 30 arc-seconds (approx. 800 meters).</td>
</tr>
<tr>
<td>3-1.</td>
<td>The 13 predictor layers used in aspen classification model.</td>
</tr>
<tr>
<td>3-2.</td>
<td>Description of aspen stand types used for Cedar Mountain classification.</td>
</tr>
<tr>
<td>3-3.</td>
<td>Gradient of pixels, hectares, and percentage classified for each stand type.</td>
</tr>
<tr>
<td>3-4.</td>
<td>Error matrix generated in See5 utilizing 20% of training/reference data.</td>
</tr>
<tr>
<td>3-5.</td>
<td>Error matrix for Cedar Mountain aspen stand type classification.</td>
</tr>
<tr>
<td>4-1.</td>
<td>PRISM 2006 monthly and annual climatic data for Cedar Mountain, Utah (37.56248 N 113.0632 W) are given. Maximum (Tmax) and minimum (Tmin) temperature (Celsius), and precipitation (mm) were averaged for period from 1971 through 2000. The spatial resolution for this data set was 30 arc-seconds (approx. 800 meters).</td>
</tr>
<tr>
<td>4-2.</td>
<td>The 13 predictor layers used in aspen health classification model.</td>
</tr>
<tr>
<td>4-3.</td>
<td>Gradient of pixels, hectares, and percentage classified for each health class.</td>
</tr>
<tr>
<td>4-4.</td>
<td>Error matrix for Cedar Mountain aspen stand type classification.</td>
</tr>
<tr>
<td>4-5.</td>
<td>Tukey-Kramer multiple comparisons test for elevation, slope, and aspect against different aspen cover types.</td>
</tr>
<tr>
<td>A-1.</td>
<td>Criteria for the Cedar Mountain aspen stand type cover classes.</td>
</tr>
<tr>
<td>A-2.</td>
<td>Example of a portion of an excel spreadsheet used to convert sample point data into a .txt file. The first two columns are composed of coordinates and the third is the site stand type. This file is used as the dependant variable in the decision tree classifier.</td>
</tr>
</tbody>
</table>
A-3. Portion of the attribute table for NAIP validation points indicating the “ID” or map cover type and the NAIP based cover type. ............................................................. 126

A-4. Error matrix for Cedar Mountain aspen stand type classification.................. 127
<table>
<thead>
<tr>
<th>Figure</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1.</td>
<td>Map showing the potential distribution of quaking aspen across North America (Little 1971).</td>
</tr>
<tr>
<td>1-2.</td>
<td>A deteriorating aspen stand on Cedar Mountain illustrating no live overstory and little to no regeneration.</td>
</tr>
<tr>
<td>1-3.</td>
<td>The study area located in southwestern Utah.</td>
</tr>
<tr>
<td>2-1.</td>
<td>Self thinning of young aspen sucker populations follow a negative exponential decay model. Data are from an aspen study in the Rocky Mountains (Sheppard, 1993).</td>
</tr>
<tr>
<td>2-2.</td>
<td><em>Ceratosystis</em> stem canker at a study site on Cedar Mountain in Southern Utah. Note the target-like concentric growth rings.</td>
</tr>
<tr>
<td>2-3.</td>
<td>Landscape view of large-scale aspen decline surrounding Miner’s Peak on Cedar Mountain in southern Utah (2008).</td>
</tr>
<tr>
<td>2-4.</td>
<td>Site on Cedar Mountain Utah illustrating SAD characteristics. Note: complete aspen overstory mortality with no regeneration. Roots systems have regressed, resulting in aspen loss from the landscape.</td>
</tr>
<tr>
<td>3-1.</td>
<td>The Cedar Mountain study area.</td>
</tr>
<tr>
<td>3-2.</td>
<td>Un-delineated portion of a NAIP image.</td>
</tr>
<tr>
<td>3-3.</td>
<td>Aspen delineated portion of a NAIP image.</td>
</tr>
<tr>
<td>3-4.</td>
<td>Map of the Cedar Mountain, UT study area with training data systematically overlaying the aspen cover mask.</td>
</tr>
<tr>
<td>3-5.</td>
<td>General mapping process for the aspen stand type classification.</td>
</tr>
<tr>
<td>3-6.</td>
<td>Final aspen health classification map containing three mapped classes for the Cedar Mountain study area.</td>
</tr>
<tr>
<td>4-1.</td>
<td>Study area located southeast of Cedar City, UT. Inset box indicates location of study area situated on the Kolob Terrace within the Markagunt Plateau.</td>
</tr>
</tbody>
</table>
4-2. Map of study area with training data systematically lain within aspen cover mask ..................................................................................................................................................101

4-3. The 4 ancillary datasets (predictor layers) used in the model derived from 30-m DEM; Slope (in degrees), elevation, aspect (moisture index), and a 10-class landform dataset (Manis et al (2001). .........................102

4-4. General mapping process for the aspen health classification.................................103

4-5. Final aspen stand type classification map containing three mapped classes for the Cedar Mountain study area..................................................................................104

4-6. Elevation means (122) of each aspen stand type on Cedar Mountain ..........105

A-1. Example of deciphering aspen health stand types.............................................118

A-2. 500m grid (446 points) generated in the delineated aspen mask used to validate the final aspen stand type map for Cedar Mountain..............................127

A-3. NAIP imagery used during the validation process.............................................128

A-4. Same NAIP image as the base layer with the aspen stand type map overlain. Comparing the model map and the NAIP imagery was the core procedure used to generate accuracy assessments for the Cedar Mountain application..128

A-5. KHAT statistic equation.........................................................................................129
CHAPTER 1

INTRODUCTION

Quaking aspen in western landscapes

Quaking aspen (*Populus tremuloides*, Michx.) is the most widely distributed native tree species in North America (Fig. 1-1), corresponding broadly with the North American boreal forest distribution southward to lower latitudes in Mexico (Baker, 1925). Aspen is the predominant deciduous tree of the Rocky Mountain region, with the highest abundances in Colorado and Utah (Preston, 1976; Bartos, 2008). Aspen is a resilient species and exhibits large ecological amplitude, which contributes to its wide distribution throughout North America (Lieffers et al., 2001). Aspen are valued for forage production, understory diversity, wildlife habitat, watershed protection, water yield, timber products, and aesthetic appeal (Preston, 1976; Johnson et al., 1985; Bartos and Campbell, 1998; Bartos, 2001; LaMalfa and Ryel, 2008). Ecologically, aspen are regarded as keystone species, contributing greatly to biodiversity in a landscape dominated by coniferous forests (Kay, 1997). Aspen dominated sites are second to riparian zones in overall biodiversity on western landscapes (Kay, 1997), providing habitat for many plants (Mueggler, 1985, 1988; Chong et al., 2001), large and small mammals (DeByle, 1985), birds (DeByle, 1985; Johns, 1993; Struempf et al., 2001), and insects (Chong et al., 2001).

Despite its apparent merits, however, aspen communities in the Intermountain Region of the western United States are in evident decline (Bartos and Campbell, 1998; Bartos, 2001), with certain areas experiencing rapid mortality over the past decade (Worrall et al., 2008). Much of the aspen decline noticed in the Intermountain West has
been associated with divergent factors across spatial and temporal scales. Factors contributing to aspen decline include: Holocene climatic change and 20th century fire suppression leading to conifer succession; overgrazing of regenerating suckers via domestic and wildlife ungulates (Bartos, 2001; Sexton et al., 2006); and the impacts of disease and insect outbreaks on stressed aspen stands (Hogg and Schwarz, 1999). If historical trends of management and utilization of these aspen landscapes continue, the result may be continued loss of aspen cover as well as the forfeiture of resource value.

Aspen is an aesthetically and commercially important species in the Intermountain West. Approximately 75% of aspen in the western United States are found in Utah (25%) and Colorado (50%) (Bartos, 2001). Occupying over 3.5 million acres throughout the Intermountain West (Fig. 1-1), aspen is widely valued for its sociological, ecological, and hydrological merit. In the western U.S., Johnson et al. (1985) and McCool (2001) are among the few to publish about the sociological and aesthetic resources aspen offer to recreationists and nature enthusiasts, as well as how these attributes influence aspen management.

Historically, aspen was not considered an economically regulated species and was not inventoried until recently. Thus, aspen contributed little commercial value to the timber and pulp economies of the Western U.S. This is largely due to the low stumpage prices and high extraction costs associated with remote aspen forestry operations (Wengert et al., 1985). However, the aspen timber market has recently expanded with increasing demand found in specialty products, construction lumber, and furniture.

Ecologically, aspen dominated landscapes provide diverse habitats for a variety of flora and fauna. Aspen canopies offer significantly different overstory and understory
characteristics throughout its distribution, creating highly productive systems that support high levels of biodiversity (Kay, 1997) and forage production (Mueggler, 1985).

Hydrologically, aspen dominated watersheds have been found to have greater potential water yield for runoff and groundwater recharge per annum than coniferous watersheds, a result from differences in peak snow water equivalent and net summertime evapotranspiration (LaMalfa and Ryel, 2008).

In the Intermountain West, aspen are thought to exist as two major condition types (Bartos and Campbell, 1998): 1) persistent, and 2) successional to conifers (seral). Persistent stand types are currently composed of stable and damaged (declining, deteriorating) stand conditions. Stable aspen stands maintain persistence over time, often containing pure over stories, good stand structure (i.e. numerous age cohorts), adequate regeneration, and diverse understory forbs and shrub communities (Mueggler, 1988; Bartos, 2001; Kurzel et al., 2007). Due to the diverse nature of stable aspen stands, they tend to be more resilient to disturbance (e.g. insect infestations and disease), invasion by introduced species, and maintain water balance between and within vegetation communities more effectively. Damaged aspen stand types are characterized by overstory mortality, poor stand structure (e.g. single, old cohort), weak regeneration, presence of disease, altered understory communities, largely referring to the decline of persistent aspen stands (Bartos, 2001; Fig. 1-2). Even though marginal regeneration may exist in many decadent stands, repetitive wild and domestic ungulate browsing may diminish carbohydrate reserves stored in roots, leading to root loss and ultimately aspen from the landscape.
The other major aspen condition type is the successional form, or also known as seral aspen (Bartos, 2001). In these stands, aspen and conifers inhabit the landscape simultaneously. Aspen in these systems are regarded as the early successional, disturbance, or pioneer species since they were generally the first to establish following fire, disease, or other disturbances. Aspen reestablish primarily by root suckers that are able to dominate the landscape more rapidly than conifers, which are dependent on seed for establishment. Aspen may continue to dominate the forest landscape on conifer-climax sites for many years, potentially centuries, before eventually declining as the more shade-tolerant conifers reestablish. Once conifers mature, aspen canopies begin to break up as a result of conifer shading (Looke, 1971; Schier, 1975). In boreal forests, this successional process confines aspen to the warmest landscape positions where solar radiation is often highest, resulting in higher densities of aspen regeneration (Van Cleve et al., 1983). Although many seral stands in the Intermountain West are dependent on disturbance to maintain new cohort recruitment, Kurzel et al. (2007) suggest that some seral aspen stands appear to be perpetuating for decades and sometimes centuries despite conifer presence. However, with 20th century fire suppression and Holocene climatic change largely inhibiting aspen regeneration, many areas in the Intermountain West once dominated by aspen are succeeding to conifers.

Goals and objectives

The increased awareness of aspen decline (Bartos and Shepperd, 2008) throughout the Intermountain West (esp. southern Utah and southwestern Colorado) has spurred an interest for improved protocols that better assess and manage aspen decline
from a broad, landscape scale. Therefore, appropriate methods must first be developed to map and spatially delineate areas exhibiting aspen decline. The goal of this work was to develop appropriate methods for assessing aspen stand type and condition using remote sensing at the landscape scale, and applying this to assess aspen condition on Cedar Mountain, Utah.

Following is a list of objectives addressed in this study:

1. Develop a quantitative approach to identify and map aspen stand types within the Cedar Mountain area using multispectral data and ancillary information.
2. Develop a map of aspen condition within the Cedar Mountain study area.
3. Quantify relationships between aspen stand condition and landscape metrics within the Cedar Mountain area.

Outputs from this research will be a spatial and tabular data source of present aspen health and distribution for the Cedar Mountain study area that will be useful to land managers working on Cedar Mountain and to land managers working in similar aspen landscapes in the Intermountain West. Further, the techniques developed here can be applied to other landscapes in order to quantify aspen health and distribution over a wide landscape.

Remote sensing and geographic information systems (GIS) technologies can offer a reliable and accurate means to examine the extent and magnitude in areas exhibiting aspen decline. Using these tools, a geospatial resource can be developed to assist local land managers identify and locate aspen stands, and subsequently design, and implement restoration efforts for declining aspen stands.

The goals of the study were to develop an approach to spatially quantify aspen
stand condition at the landscape level and to assess landscape characteristics related to stand condition. To this end, three aspen stand classes were selected to represent persistent and seral aspen conditions for Cedar Mountain. Persistent conditions were segregated into 1) healthy, and 2) damaged. Successional condition were given only one category labeled 3) seral. Additionally, the topographic characteristics of slope, aspect, and elevation associated with healthy, damaged, and seral aspen stands were examined to establish relationships between stand classes and each topographic characteristics within a GIS environment.

Study area

The study area is located on Cedar Mountain near the boundaries of Iron, Washington, and Kane counties in Southern Utah, approximately 27 kilometers southeast of Cedar City (Fig. 1-3). The study area on Cedar Mountain covers approximately 27,000 hectares and is situated within the Kolob Terrace, a broad, relatively flat, lowered southwestern tier of the Markagunt Plateau within the Southern Rocky Mountains Ecoregion Province. In the Ecoregion framework (McNab and Avers, 1994; Bailey 1998), the Kolob Terrace is bounded to the north and northeast by the western rim of the Markagunt Plateau, while its western side descends abruptly into the southwestern portions of the Great Basin. The areas southern boundary gently descends into the arid Central Canyonlands of Zion National Park of the Colorado Plateau.

The study area lies between 2,400 -3,162 meters elevation with slopes ranging from 0 to 28%. PRISM weather data mean annual precipitation for the study area between 1971 and 2000 was approximately 864 mm per year (Table 1-1), which is often
expressed in a moderately bimodal seasonal trend mainly as winter snowfall and summer monsoons. The annual average high temperature for the 30-year period was 8.39 °C. Soils are predominantly Argic Pachic Cryborolls, fine montmorillonitic fain clay loam (Bowman and Bagley, 1986).

The vegetation communities within the study area can be described in relation to landform. Upland, broader ridges and canyon bottoms are comprised of big sagebrush (*Artemisia tridentata*, Nutt.) with understory herbaceous cover dominated by Letterman needlegrass (*Stipa lettermani*, Vasey), mountain brome (*Bromus carinatus*, Hook & Arn), Kentucky bluegrass (*Poa pratensis*, L.), and slender wheatgrass (*Elymus trachycaulus* (Link) Gould ex Shinn). The lower elevation ridges and drier canyon sites were populated with big sagebrush (*Artemisia tridentata*, Nutt.) patches of mountain snowberry (*Symphoricarpos oreophilus*, Gray) and Gambel Oak (*Quercus gambelii*, Nutt.). On the southern portions of the study area near Kolob reservoir, Crystal Creek, and O’Neil drainages, Gambel Oak is the dominant canopy cover on southeast to west facing lower elevation slopes, while aspen begins to dominate the upper ridges and slopes.

The northern portions of the study area often exhibit higher elevations with steep slopes into Cedar Canyon proper and into the lower portion of the Markagunt Plateau near Cedar Breaks National Monument. These northwest and northeast facing higher elevation slopes are generally are dominated by mixed aspen-conifer and conifer communities. Conifers present on these landforms consisted of Engelmann spruce (*Picea engelmannii*, Parry), subalpine fir (*Abies lasiocarpa*, Nutt.) and Douglas-fir (*Pseudotsuga menziesii*, Mirb). In general, the majority of Kolob Terrace and the Cedar Mountain
study area exhibit relatively flat terrain with many mountain meadows and a
preponderance of persistent quaking aspen woodlands, with spruce-fir and aspen-conifer
forests interspersed peripherally.

Cedar Mountain is predominately privately owned with small pockets near the
north-eastern boundary of the study area being federally managed within the Dixie
National Forest. On both the private and federal sector, the land has been historically
grazed since the 1860’s by sheep and cattle. This impact is considered to be the main
driver for conversion from its historical tall forb community to the present graminoid
community (Bowns and Bagley, 1986). Historically, Cedar Mountain in general has
experienced few fires over the past two centuries, a likely artifact of historical heavy
grazing pressure and strong efforts for fire suppression efforts.

References

Bailey, R.G., 1998. Ecoregions: The Ecosystem Geography of the Oceans and
Continents. Springer-Verlag, NY.

Baker, F.S., 1925. Aspen in the central Rocky Mountain Region. USDA Department
Bulletin, Number 1291.

Sheppard, D. Binkley, D.L. Bartos, T.J. Stohlgren, and L.G. Eskew (comps.),
Sustaining Aspen in Western Landscapes: Symposium Proceedings. USDA Forest

Rocky Mountain Research Station., editor. In: Chambers, Jeanne C.; Devoe,
Nora; Evenden, Angela (Eds). Collaborative management and research in the
Great Basin - examining the issues and developing a framework for action. Gen.


Bartos, D.L., Sheppard, W.D., 2008. Sudden Aspen Decline Summit Report, 12-


Table 1-1. PRISM 2006 average monthly and annual climatic data for Cedar Mountain, Utah (37.56248 N 113.0632 W) are given. Maximum (Tmax) and minimum (Tmin) temperature (Celsius), and precipitation (mm) were averaged for period from 1971 through 2000. The spatial resolution for this data set was 30 arc-seconds (approx. 800 meters).

<table>
<thead>
<tr>
<th>Year</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Apr</th>
<th>May</th>
<th>Jun</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tmax</td>
<td>-0.87</td>
<td>0.45</td>
<td>2.47</td>
<td>6.07</td>
<td>10.63</td>
<td>16.49</td>
</tr>
<tr>
<td>Tmin</td>
<td>-11.12</td>
<td>-10.82</td>
<td>-8.88</td>
<td>-6.01</td>
<td>-1.07</td>
<td>3.96</td>
</tr>
<tr>
<td>Ppt</td>
<td>100.92</td>
<td>117.61</td>
<td>139.12</td>
<td>75.15</td>
<td>57.72</td>
<td>23.82</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Apr</th>
<th>May</th>
<th>Jun</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year</td>
<td>Jul</td>
<td>Aug</td>
<td>Sep</td>
<td>Oct</td>
<td>Nov</td>
<td>Dec</td>
</tr>
<tr>
<td>Tmax</td>
<td>19.72</td>
<td>18.95</td>
<td>14.88</td>
<td>9.15</td>
<td>3.2</td>
<td>-0.44</td>
</tr>
<tr>
<td>Tmin</td>
<td>7.33</td>
<td>6.64</td>
<td>2.81</td>
<td>-2.19</td>
<td>-7.78</td>
<td>-10.8</td>
</tr>
<tr>
<td>Ppt</td>
<td>44.41</td>
<td>54.52</td>
<td>51.99</td>
<td>63.91</td>
<td>70.59</td>
<td>64.27</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year</th>
<th>Annual</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tmax</td>
<td>8.39</td>
</tr>
<tr>
<td>Tmin</td>
<td>-3.16</td>
</tr>
<tr>
<td>Ppt</td>
<td>864.03</td>
</tr>
</tbody>
</table>
Figure 1-1. Map showing the potential native distribution of quaking aspen across North America (Little, 1971).
Figure 1-2. A declining aspen stand on Cedar Mountain illustrating no live overstory and little to no regeneration.
Figure 1-3. The study area located in southwestern Utah.
Aspen ecology

Aspen throughout western North America occur across a large ecological amplitude. Lieffers and others (2001) have suggested the following traits that aspen have that permit its wide distribution. Aspen is very stress tolerant among the genus *Populus* genus, a unique characteristic often associated with slow growing species with limited reproductive strategies. Aspen are more dependent on vegetative reproduction through root suckering, enhancing the ability to tolerate varying climatic stress (DesRochers and Lieffers, 2001). Aspen have the ability to adapt leaf size to accommodate xeric or mesic site conditions. In drier or droughty climates, aspen tend to grow smaller leaves to keep surface temperatures down, allowing stomata to close earlier and prevent water stress (Mueggler, 1989). Aspen also tend to cope with shorter growing seasons and cold temperatures better than most hardwoods. This attribute allows aspen to grow in higher elevations than most hardwoods (Pearson and Lawrence, 1958). Another adaptive advantage aspen exhibit is the ability to flutter leaves to cool leaf surfaces and produce sunflecks that deliver direct sunlight to the understory. Lastly, aspen have been found to have very good photosynthetic capabilities relative to most other species of its genus. Aspen can photosynthesize very well in low light conditions. The bark is also photosynthetically active which improves respiration during high periods of insolation (Pearson and Lawrence, 1958), ameliorates recovery after injuries and disease infestations (Lieffers et al., 2001), and allows the plant to photosynthesize at low levels
during winter months prior to leaf-out (Pearson and Lawrence, 1958; Sheppard et al., 2004). Aspen has long been known to reproduce profusely (≤ 200,000 stems per hectare) following a disturbance via extensive asexual vegetative suckering from parent root systems (Baker, 1925). Generally following a disturbance, initial high sucker counts tend to self-thin following a negative exponential decay model, with the most evident decline occurring during the first few years following the disturbance (Fig. 2-1, Sheppard, 1993).

The primary mechanism driving the vegetative suckering process is the ratio of growth hormones, primarily auxin (notably indole-3-acetic acid (IAA)) and cytokinin growth hormones found in the roots and apical meristem (Schier, 1976). Following a disturbance, aspen exhibit major fluxes in these growth hormones, which mediate the extent at which apical dominance inhibits sucker initiation. Auxins have been found to inhibit sucker bud initiation and promote root growth, while cytokinins are believed to counteract the activity of auxins by stimulating sucker initiation. When the aspen overstory is receiving adequate sunlight, auxins are transported to the root system to effectively suppress new regeneration. In the event of aboveground mortality or root disturbance, auxin production is drastically reduced allowing cytokinin concentrations to increase and stimulate bud primordial on roots to develop into new sucker sprouts.

Despite the primary role of auxins and cytokinins on sucker initiation, other growth regulators (e.g. abscisic acid, ethylene, and gibberellins) (Schier, 1981), food reserves (carbohydrates) (Schier, 1981), and environmental factors, such as soil temperature, pH, and nutrient availability (Zasada and Schier, 1973; Bartos and Mueggler, 1981; Alban, 1982; Feller, 1982) play important roles in apical dominance of aspen.
Although successful sexual reproduction in aspen is believed to be minimal due to stringent site requirements needed for successful germination, recent genetic research suggests sexual reproduction in aspen is a stronger contributor to genetic diversity than previously believed (Mock et al., 2008). This subfield of aspen genetics is beginning to question previously held assumptions regarding aspen life history. Previous aspen literature largely suggests aspen “stands” to be synonymous with clones, which tend to be characterized by phenotypic characteristics, such as timing of leaf-out and color during autumn senescence (Miller, 1996). However, many studies have shown that clone intermixing is more common than previously believed, and relying solely on phenotypic characteristics to distinguish individual clones (Mitton and Grant, 1980) can often be misleading.

Clonal size is often a response to favorable growing conditions and disturbance frequencies. Hipkins and Kitzmiller (2004) found monoclonal stands in the Sierra Nevada to be smaller on average (0.32 ha) comparatively to multiclonal stands (1.24 ha) due to the rare occurrence of favorable conditions where the monoclonal stands existed. In comparison to the Interior West findings, clone sizes were found to be substantially larger, ranging in size up to 200 acres (80.94 ha) (Kemperman and Barnes, 1976). It was hypothesized that these larger aspen clones were acting under semi-arid conditions where suitable seed germination environments are scarce, resorting primarily on vegetative suckering following disturbances to bolster longer lasting and larger clones (Kemperman and Barnes, 1976).

Not until recently has the Intermountain West region of aspen distribution been genetically examined using modern genetic techniques. Mock et al. (2008) tested the
ancient clone hypothesis, the perception that aspen landscapes in the Intermountain West are dominated by low numbers of ancient clones (8,000-10,000 years old) that expand primarily via asexual vegetative reproduction. In this study, Mock et al. (2008) examined two large aspen sites in Utah representing xeric conditions found in the central and southern Rocky Mountain region. Results suggested a far larger number of clones in both study areas than previously assumed. The large range of clone sizes at both study sites suggested differences in clonal rate of expansion, timing of establishment, and decline among clones. These factors may attribute to the distinctive clustering of small clones on north and northeast edges of larger clones, suggesting a pattern of successful seeding event(s) following the establishments and spread of larger clones, or a disrupted disturbance history or environmental conditions; evidence supported by historical 20th fire suppression and Holocene climatic change.

A wide range of clonal size, diversity, and heritability of phenotypic traits exist that broadly characterize different functional aspen forests. Seven functional forms of aspen have been described for the Sierra Nevada range and may extend into the Intermountain West region to some degree; Meadow fringe, Riparian, Upland aspen/conifer, Lithic, Snow pocket, Upland pure, and Krummholz aspen (Sheppard et al., 2006). Each functional group illustrates varying degrees of stand structure, dynamics, understory communities, and growth potential, each influenced by the gene pool within stands. Furthermore, aspen stand characteristics are further diversified via abiotic environmental variation within air temperature, soil types, and ecohydrology. Ultimately, the differences in stand functionality have profound management and research implications. These factors need to be accounted for in future studies if aspen dynamics
such as regeneration, ungulate herbivory, disease susceptibility, carbon dynamics, and age structure are to be properly attributed to aspen as a species rather than a clone.

Changes in environmental factors throughout the Intermountain West have reduced aspen distribution since the early 20\textsuperscript{th} century. Aspen are susceptible to a number of diseases, insects, and other damaging agents that can affect aspen health and vigor. A number of damaging agents that affect aspen are fungal pathogens, wood-boring insects, bark beetles, foliage diseases, defoliating insects, and various forms of physical damage (Sheppard et al., 2006).

Aspen’s wide distribution across North America presents the species with a diverse spectrum of decay fungi. The frequent incidence of aspen stands with decay fungi suggests they have an important role in aspen mortality (Sheppard et al., 2006). Decay of trunks, butts, and roots of aspen are often due to \textit{Phellinus tremula} and \textit{Armillaria} spp. \textit{Phellinus tremula} infect the living bark phloem tissue in trunks and \textit{Armillaria} affects the root and butt of the bole making aspen increasingly susceptible to snow or wind breakage. Since \textit{Armillaria} spreads intensively amongst rhizomorphs between trees, all roots at the source of the disease usually die with no suckering. Generally, \textit{Armillaria} kills less vigorous aspen (Peterson and Peterson, 1992); however it has been suggested that \textit{Armillaria} may be a driving factor in aspen decline by weakening and killing healthy trees (Brandt et al., 2003).

The relatively thin, live bark of aspen makes it susceptible to an array of stem canker diseases. Canker causing fungi produce toxins that can wound, girdle, and kill aspen by inhibiting the flow of photosynthates to the roots. Common genera of stem canker diseases that are found in the western US include \textit{Cenangium}, \textit{Ceratocystis} (Fig.
2-4), and Cryptosphaeria (Hinds, 1985), whereas Nectria, Cytospora, and Hypoxylon are more common in western Canada and eastern North America (Hinds, 1985). Among wood-boring insects, aspen is primarily susceptible to the bronze poplar borer (Agrilus liragus) and the poplar borer (Saperda calcarata). The bronze poplar borer has been found to be associated with stressed trees suffering from drought (Ives and Wong, 1988). The remnant holes left from borers provides an entry point for various stem canker diseases that can lead to windthrow. Both poplar borer species were associated with the rapid aspen mortality occurrence in southwestern Colorado (Worrall et al., 2008).

Although bark beetle infestations among aspen are rare, Worrall et al. (2008) found Trypophloeus populi and Procryphalus mucronatus as secondary damaging agents associated with aspen mortality in southwestern Colorado, US. When present, aspen bark beetles often target weakened or water stressed stands during drought conditions.

Foliar diseases and defoliating insects have been found to attack aspen leaves and can significantly reduce carbon (C) uptake in many aspen stands. Ink-spot (Ciborina whetzelii) is a periodic fungal disease that damages overstory leaves, but generally does not account for any significant mortality. Aspen tortrix (Choristoneura conflictana) and western tent caterpillar (Malacosoma californicum) are the most serious defoliators for aspen in the western North America, with numerous documented episodes of serious defoliation resulting in mortality from northern US down into Mexico (Jones et al., 1985).

Aspen is regarded as a disturbance dependent species and has evolved reproductive strategies to absorb physical damages such as snow damage, windthrow, and herbivory. In the cordilleran forests of western North America, herbivory of aspen
by elk, deer, moose, sheep, bear, beavers, and small rodents (DeByle, 1985), and disease exacerbated by browsing pressure (Hart and Hart, 2001) have been attributed to localized die-offs. Kay (1993) and Sheppard et al. (2004) have reported successful regeneration following disturbances that in subsequent winter seasons were unable to establish due to excessive elk (*Cervus elaphus*) browsing. Domestic and wild ungulates densities have increased substantially since Euro-American settlement, with certain areas in western North America experiencing ungulate densities higher than ever previously recorded (Kay et al., 1999). Subsequently, the repeated annual effects of herbivory by wild or domestic ungulates over a period of time can lead to the lack of overstory regeneration, lowering the likelihood of sustaining aspen into the future on heavily browsed sites.

In recent years, the reintroduction of wolves (*Canis lupis L.*) into some western landscapes has created positive feedback loops that have improved aspen recruitment. For example, the presence of top predators in these areas have been found to reduce native ungulate densities, browsing pressure, and alter foraging behavior in many heavily utilized wintering grounds (Halofsky et al., 2008). However, with many areas in the western North America void of historical ungulate predators and private management organizations supporting high densities of native ungulates, this ungulate herbivory becomes a significant driver of aspen decline by severely reducing viable aspen recruitment.

Although quaking aspen is the most widely distributed native tree species in North America, aspen communities in the Intermountain West are in evident decline, with certain areas experiencing rapid mortality over the past decade (Worrall et al.,
Much of the aspen decline noticed in the Intermountain West has been associated with divergent spatial and temporal factors. Among the factors contributing to aspen decline include, Holocene climatic change (i.e. drought); 20th century wildfire suppression leading to conifer succession (Bartos, 2001); domestic and native ungulate browsing of regeneration (Bartos, 2001; Sexton et al., 2006); and the impacts of disease and insect outbreaks on stressed aspen stands (Hogg and Schwarz, 1999).

Historically, aspen decline has been observed across North America and has been attributed to a myriad of causes. High mean annual temperatures in the northern Great Lakes region during the 1970’s was found to contribute to widespread aspen decline in stands with open canopies (Shields and Bockheim, 1981). These stands were subject to widespread cutting and fire during the early 20th century, creating mature stands susceptible to the replacement of shade-tolerant, later successional species (Fralish, 1975). Also in Canada, the Prairie Provinces experienced a similar die back, growth loss, and mortality of aspen during the 1980’s and early 1990’s due to drought conditions for the region (Brandt et al., 2003). In this instance, insect defoliation followed by secondary wood-boring insects and diseases attacked water stressed trees.

In the United States, numerous studies have documented aspen decline over the past century. Di Orio et al. (2005) examined aspen in the South Warner Mountains of California and found a 24% decline of aspen cover over a 48 year period. They found an increase in decline with increasing warming trends. Recently on Cedar Mountain in southern Utah, numerous time series analyses have found that approximately 23% of the 1985 historical aspen cover has declined over the past 25 years (Fig. 2-3) (D. Evans, personal communication). The study correlated low snow water equivalent measures
with subsequent aspen decline events, with the most pronounced loss occurring during
the late 1990’s and early 2000’s. Rogers (2002) utilized Forest Health Monitoring
(FHM) data from Idaho, Wyoming, and Colorado and found a marked decline in quaking
aspen over the past 100 years, supporting the hypothesis that conifer succession and fire
suppression are responsible for a century of aspen decline. During the 1970’s, similar
factors were believed to be related to a widespread decline of aspen in the inland west,
specifically Utah and western Wyoming (Schier, 1975). In addition to overstory
mortality, these deteriorating stands contained insufficient suckering coupled with
shrinking root systems. Shepperd (2001) found aspen stands in southern Utah had lower
root densities than adjacent healthy stands, concluding if lateral roots are dead,
regeneration will cease and aspen will not continue to persist on site.

More recently, rapid rates of aspen mortality were noticed in southwestern Colorado
(Worrall et al. 2008), northern Arizona (M.L. Fairweather, personal communication),
southern Utah (J. Bowns, personal communication), and Montana (W.D. Sheppard,
personal communication). These more recent accounts of rapid aspen mortality have
striking similarities in their relative suddenness, synchronicity, and severity,
characteristically different than the widely used “aspen decline” term that refers to either
advancing conifer succession or the gradual deterioration (10-20 yrs or more) of vigor
and health that eventually results in widespread mortality (Sinclair and Lyon, 2005).

In southwestern Colorado, Worrall et al. (2008) was among the first to publish on
this type of rapid mortality and found that the rapid nature of this mortality event,
mortality agents involved (fungal pathogens, wood-boring insects, aspen bark beetles),
and the climatic and bio/physical causal factors operating under an altered disturbance
regime, distinguish this event from the typical long-term aspen decline usually related to successional processes. Aspen decline operating under the context of rapid mortality found in these areas tend to be consistent with the tree disease hypothesis proposed by Manion (1991) that describes three processes/factors associated with decline; inciting factors, predisposing factors, and contributing factors.

Inciting factors such as drought, insect defoliation, air pollution, and frost/thaw events are short-term, stressing factors that occur prior to a large-scale decline event. Predisposing factors are long-term, chronic stresses that increase susceptibility to inciting factors, such as climate, successional processes, stand structure, genetics, and age. Lastly, contributing factors are secondary agents that often kill a stand following an inciting event, such as insect borers, pathogens, and windthrow. Under these declining processes, the recent accounts of rapid aspen mortality tend to be consistent with this hypothesis. In southwestern Colorado (Worrall et al., 2008), northern Arizona (M.L. Fairweather, personal communication), and Cedar Mountain in southern Utah (J. Bowns, personal communication), each area has experienced acute drought and extended high temperatures in the past 5-10 years (inciting factors), contain declining stands with older stand structures and low stand densities at lower elevation, south to southwest aspects where solar radiation is most pronounced (predisposing factors), and exhibit numerous secondary biotic agents prevalent to mortality areas (fungal pathogens, insect borers) that function as contributing factors to rapid aspen mortality.

The recent rapid aspen mortality events noticed throughout the Intermountain West convey a unique combination of predisposing, inciting, and contributing factors that are resulting in unusual high rates of aspen being removed from the landscape, in many
cases, with minimal recruitment and often exacerbated by excessive ungulate browsing. This recent phenomenon is being referred to as Sudden Aspen Decline (SAD) and is characterized by overstory mortality with little to no understory regeneration (Bartos and Shepperd, 2008). Although the topic of SAD has been elevated in prominence in both the popular media and scientific communities, the application and designation of SAD stands is nebulous. Although many cases of SAD may be anecdotal, the extent and rapid nature of the recent aspen decline is clearly apparent in many areas throughout the Intermountain West. The interwoven relationship between drought, high grazing and browsing intensities, insect and pathogens, and deteriorated root systems appear to be increasing the loss of aspen from the landscape.

Remote sensing/GIS modeling

In recent years, remote sensing technologies have played pivotal roles in modern terrestrial ecology, being utilized to model biogeochemical cycles (Schimel, 1995), vegetation biophysical attributes (Lymburner et al., 2000), biodiversity and fragmentation (Nagendra, 2001), land cover and change detection (Lowry et al., 2007), and forest structure and health (Lim et al., 2003). In forest research and management, an array of instruments have been used to acquire remotely sensed spectral data, such as the airborne Thematic Mapper Simulator (TMS), SPOT High Resolution Visible (HRV), Advanced Very high Resolution Radiometer (AVHRR), Moderate Resolution Imaging Spectroradiometer (MODIS) (Barnes et al., 1998), and possibly the most widely used sensor in forestry studies, the Landsat Multispectral Scanner (MSS) and the Landsat Thematic Mapper (TM).
With the deployment of Landsat 4 satellite in 1982, the TM instrument has been widely used in forest studies due to its technical capabilities, including an instantaneous field of view (IFOV) of 30-m (spatial resolution), seven spectral bands (including one 120-m IFOV thermal band), and eight-bit radiometry. A popular use of Landsat data has been forest classification, for example, assessing timber volume, successional stage, invasive species, wildlife habitat, forest fragmentation, biodiversity, and developmental characteristics of species using multi-temporal imagery in phenology studies (Gluck and Rempel 1996; Poole et al., 1996; Cohen et al., 2001; Dymond et al., 2002; Hansen et al., 2002). Due to the spectral resolution of Landsat TM imagery, a number of forest vegetation metrics have been derived such as leaf area index (LAI), canopy moisture content, canopy cover, stand age, and biomass (Lymburner et al., 2000; Steininger, 2000; Cohen et al., 2001).

In addition to thematic classification and biophysical forest assessments, Landsat data has also been used in assessing temporal dynamics of forests using multiple temporal images. Two Landsat scenes are generally available per month at any location on the Earth’s surface; however, cloud cover and data acquisition error have reduced temporal image density in some areas. Nonetheless, multi-temporal Landsat imagery has been widely used to capture phenological events across time and assist in deciphering tree species (Blair and Baumgardner, 1977; Nelson et al., 1985; Hodgson et al., 1988; Schriever and Congalton, 1993; Wolter et al., 1995; Dymond et al., 2002; Lowry et al., 2007). Another common use of remotely sensed data is the examination of interannual vegetation changes, or more formally known as “change detection.” In forest ecosystems, change detection techniques have been used to characterize clearcut
harvesting, windfall, thinning, acid rain, salvage logging, succession, transition rates, and tree morality (Williams and Nelson, 1986; Olsson, 1994; Collins and Woodcock, 1994; Helmer et al., 2000; Cohen et al., 2002).

More recently, a number of studies have examined vegetation spatial patterns associated with large areas. With increasing computing resources, cheap and readily available digital data, and a greater ability to process and analyze large quantities of data, mapping large areas has become more practical to implement. Large-scale projects such as the North American Landscape Characterization (NALC) and Gap Analysis Programs have been successful in providing radiometrically and geometrically processed data sets that are available for land-cover and change detection analyses across North America (Homer et al., 1997; Schrupp et al., 2002; Heilman et al., 2002; McRoberts et al., 2002; Lowry et al., 2007).

Classification and Regression Tree (CART) (Breiman et al., 1984) has become a widely popular method of statistical analysis used in many studies, including image processing (Lawrence and Ripple, 2000; Lawrence and Wright, 2001; Lowry et al., 2007). CART is a rule based statistical method that creates hierarchical trees using binary recursive partitioning. Largely, observations (sample points) pass down through a tree via a series of splits, or nodes, where a binary decision is made based on the explanatory variable used at the node, eventually reaching a terminal node or leaf and a predicted response is provided for the observation.

CART analysis has become a convenient and robust statistical method in multivariate analysis due to a number of advantages. CART is a non-parametric model requiring no a priori knowledge on the data, thus transformations are not needed to adjust
for normality, missing values, or outliers. Also, CART handles categorical and continuous data equally well, a particularly convenient attribute for remote sensing studies. Lastly, the boundaries are data driven rather than based on linear relationships, providing ease of tuning to any given model.

Traditionally, many remote sensing studies utilizing land-use/land-cover classifications largely relied on spectral information derived from the images, functioning as the primary determinants on the accuracy of classifications (Jensen and Cowen, 1999). The addition of ancillary data, or independent variables generally derived from existing GIS data (e.g. tassel cap transformations, multi-date composites, vegetation indices, textural information, or topographic data) to complement spectral data has been found to increase explanatory power in many remote sensing applications, especially in classifications utilizing CART analysis that can process both categorical and continuous variables. Ancillary datasets were first used for stratification purposes, post-classification sorting, or logical channel additions (Jensen, 1996). These applications were not directly incorporated into the actual classification, but functioned as segregates to reduce confusion among classes (Vogelmann et al., 1998). More recently, the addition of ancillary datasets in modern classification techniques have been met with considerable success. Methods such as expert systems, neural networks, CART, and Random Forest incorporate the ancillary datasets into the actual classification algorithms with no dependency on a priori knowledge. Classification techniques using both spectral data and ancillary data has been found to lead to greater overall accuracy, precision, and class distinctions (Trotter, 1991; Jensen, 1996; Lawrence and Wright, 2001; Lowry et al., 2007).
Landscape parameters, such as slope, aspect, and elevation have been useful surrogates for spatial and temporal factors that affect species distribution. Such factors include the duration, intensity, and frequency of solar radiation, precipitation, temperature, and disturbance (Beaty and Taylor, 2001; Stage and Salas, 2007). Moisture availability, a major driver in species distribution, is clearly affected by these topographic variables. For example, it is widely understood that in the northern hemisphere, north-facing aspects receive less solar radiation then south-facing aspects, and are therefore cooler and moister than south facing aspects (Stage and Salas, 2007). Topographic features also influence moisture conditions. Convex sites such as ridges tend to be drier due to increased wind and sun exposure, whereas, convex sites tend to be moist and accumulate water.

During periods of limited moisture availability, the effects of elevation gradients are increased. Because moisture limitations influence a species’ elevation range, drought periods and extended durations of warm temperatures impact a species the greatest at low elevations where evapotranspiration and solar radiation is highest (Worrall et al., 2008). Furthermore, the affects of aspect on physiological processes is greatest at a species elevation extremes (Stage and Salas, 2007). At lower elevations, southerly aspects generally exhibit the highest moisture constraints and thus represent the most susceptible ecosites for drought. At higher elevations, a species’ distribution is dictated by either physiological limitations and/or the presence of species better adapted for higher elevation conditions (Brown et al., 1998). Although moisture availability is greater at higher elevations, colder temperatures persist for longer durations, allowing only the hardiest species to persist during the shortened growing season. Many Intermountain
West forest communities are reflective of these climate-landscape relationships (Brown et al., 1998).

In light of global climate change, large shifts in precipitation regimes are occurring and are resulting in unprecedented rates of change in vegetation distribution (Allen and Breshears, 1998; Worrall, 2008). Landscape bio/physical characteristics, such as slope, aspect, and elevation, amplify the effects of changing precipitation regimes, often exacerbating drought or flood conditions. Recently in the Intermountain West, these changes have been strongest and most pronounced in semiarid ecotones, the boundaries between different ecosystems, often in the form of widespread decline of forest cover (Gosz, 1992; Allen and Breshears, 1998; Worrall et al., 2008). The most striking aspect of these climate-induced ecotonal shifts is how rapid and extensively these shifts are in conjunction with the timing of drought events. Mortality generally occurs on the most susceptible ecosites first, such as south-to-west, low elevation sites that are most water stressed. These water stressed sites often are accompanied by pathogens, insect-borers, and/or bark beetle infestations that exacerbate the mortality rates. The spatial patterns of these types of mortality events usually correspond directly to elevation/moisture gradients associated with slope and aspect (Allen and Breshears, 1998).

Numerous climate modeling studies have illustrated projections that unmitigated global warming will continue to result in the rapid shifting and/or loss of many upper elevation communities (Root et al., 2003; Rehfeldt et al., 2006). Rehfeldt et al. (2006) projected an increase of montane forest and grassland communities at the expense of subalpine, alpine, tundra, and arid woodland communities. Among communities
projected to decrease, quaking aspen illustrated a general decrease in range throughout its distribution, with Colorado and Utah indicating substantial losses. These model projections were consistent with aspen decline observed in southwestern Colorado (Worrall et al., 2008) and rapid decline of Ponderosa Pine (*Pinus Ponderosa*) in northern New Mexico (Allen and Breshears, 1998), where climate-induced ecotonal shifts resulted in considerable declines of overstory cover on moisture stressed sites. The models utilized variables derived directly from landscape biophysical and climatic variables. Of the primary predictor layers used to model aspen (among others), an annual dryness index and the ratio of growing season precipitation against mean annual precipitation illustrated the strongest predictive power, variables that are likely linked to moisture stressed areas.

**References**


Figure 2-1. Self thinning of young aspen sucker populations follow a negative exponential decay model. Data are from an aspen study in the Rocky Mountains (Sheppard, 1993).

Figure 2-2. *Ceratosystis* spp. stem canker at a study site on Cedar Mountain in Southern Utah. Note the target-like concentric growth rings.
Figure 2-3. Landscape view of large-scale aspen decline surrounding Miner’s Peak on Cedar Mountain in southern Utah (2008).
Figure 2-4. Site on Cedar Mountain Utah illustrating SAD characteristics. Note: complete aspen overstory mortality with no regeneration. Roots systems have regressed, resulting in aspen loss from the landscape.
CHAPTER 3

MODERATE-SCALE MAPPING METHODS OF ASPEN STAND TYPES:
A CASE STUDY FOR CEDAR MOUNTAIN IN SOUTHERN UTAH

Abstract

Quaking aspen (*Populus tremuloides* Michx.) is the most widely distributed tree species across North America, but its dominance is declining in many areas of the western United States, with certain areas experiencing rapid mortality events over the last decade. The loss of aspen from western landscapes has and will continue to have profound impacts on biological, commercial, and aesthetic resources associated with aspen. However, many options are available for the restoration of aspen. Advances in remote sensing technologies offer cost effective means to produce spatial and quantitative information on the distribution and severity of declining aspen at many scales.

This chapter contains the development and application of transferable remote sensing and GIS methodologies used to accurately map areas of aspen decline throughout the Great Basin and Colorado Plateau. More specifically, these methodologies were applied on Cedar Mountain in southern Utah to map three aspen stand types (healthy, damaged, and seral) successfully. Using moderate-scale imagery (2008 Landsat TM data), DEM derivatives, high resolution NAIP (National Agricultural Imagery Program, Figures 3-2 and 3-3) imagery, and a decision tree modeling approach, a spatially explicit 2008 landscape assessment of Cedar Mountain aspen was produced with an overall accuracy of 81.3% (KHAT= 0.69, n = 445). Of the total area mapped as aspen within the 12,139 ha of Cedar Mountain, healthy aspen was the most abundant with 49% (5,960 ha), followed
by damaged with 35% (4,210 ha), and seral with an estimated 16% (1,968 ha) coverage. Aspen classification maps, derived from remotely sensed digital imagery and ancillary datasets can offer objective management information to land managers to utilize when planning, implementing, and evaluating aspen restoration activities.

Introduction

Quaking aspen (*Populus tremuloides*, Michx.) is the most widely distributed native tree species in North America, occurring broadly from the northern east coast across the North American boreal forest into Alaska and southward through the Rocky Mountains into Mexico (Baker, 1925). Aspen is the predominant deciduous tree of the Rocky Mountain region, with the highest abundances in Colorado and Utah (Preston, 1976; Bartos, 2001). Communities dominated by aspen are noted for forage production, understory diversity, wildlife habitat, watershed protection, water yield, timber products, and aesthetic appeal (Preston, 1976; Bartos and Campbell, 1998; Bartos, 2001; LaMalfa and Ryel, 2008).

Despite their apparent merit, aspen communities in portions of the Intermountain West are in evident decline, with certain areas experiencing rapid mortality over the past decade (Worrall et al., 2008). Factors contributing to aspen decline include climatic change, 20th century wildfire suppression leading to conifer succession (Bartos, 2001), domestic and native ungulate browsing of regeneration (Bartos, 2001; Sexton et al., 2006), and the impacts of disease and insect outbreaks on stressed aspen stands (Hogg and Schwarz, 1999). More recently, accounts of unusually rapid rates of aspen mortality were reported in southwestern Colorado (Worrall et al., 2008), northern Arizona (M.L.
Fairweather, personal communication), southern Utah (J. Bowns, personal communication), and Montana (W.D. Sheppard, personal communication). This recent phenomenon is being referred to as Sudden Aspen Decline (SAD) and is characterized by rapid overstory mortality with little to no understory regeneration (Bartos and Shepperd, 2008). These SAD events generally occur over 2-3 years and have striking similarities in their relative sudden and synchronized nature of severity, characteristically different than the widely used “aspen decline” term that refers to either advancing conifer succession or the gradual deterioration of vigor and health (10-20 yrs or more) (Sinclair and Lyon, 2005).

There is an increased focus on the present and future forfeiture of natural resources (hydrological, biological, and aesthetic values) concomitant with the loss of aspen from the Intermountain West. Land and resource managers, however, often lack critical cost effective resources needed to properly assess and restore aspen over large areas. However, numerous advances in remote sensing applications offer land and resource managers viable options to acquire extensive spatial and quantitative information on the location, extent, and severity of aspen decline at most ownership and management levels. Aspen distribution maps, derived from remotely sensed imagery and ancillary datasets, can offer objective, large-scale management information to land managers to utilize when planning, implementing, and evaluating aspen restoration activities.

In the past decade, numerous efforts have been made to map aspen ecosystems. With an increased availability of space-borne sensors collecting imagery at multiple spatial and spectral scales (e.g. Landsat, SPOT, IKONOS, MODIS), coupled with
improved computing and processing power, scientist, analysts, and land managers alike have developed better techniques to map aspen systems at local and regional scales (Heide, 2002; Strand et al., 2007; Lowry et al., 2007). However, despite the fact that many of these studies accomplished the task of mapping aspen systems, accuracy measures were often too low and unreliable for management purposes. Furthermore, no studies have addressed SAD specifically nor discriminated pure (i.e. persistent) aspen stand types into independent classes. Perhaps the most relevant study regarding SAD was the Worrall et al. (2008) study, which utilized an aerial sketch-mapping technique to classify aspen into healthy and damaged classes. This study found extensive aspen mortality in the San Juan range of southern Colorado, strikingly similar to that found on Cedar Mountain. However, aerial sketch-mapping techniques are often very expensive and are clouded with the inherent error of subjectivity by surveyors. Consequently, estimation and classification of stand data can often be misleading and erroneous. Thus, effective remote sensing/GIS methods specifically designed to map SAD areas in the Intermountain West for management decisions is yet to be established.

To this end, we develop and apply transferable methodologies to map areas experiencing aspen decline within the Great Basin and Colorado Plateau utilizing remote sensing and GIS technologies. This analysis applied a decision tree approach (CART) utilizing Landsat Thematic Mapper (TM) derived reflectance data, topographic data from Digital Elevation Models (DEM’s), and landform data to map aspen stand classes successfully on Cedar Mountain in southern Utah (Fig. 3-1). The results were validated using NAIP high resolution aerial photography. More specifically, these methods will address the following: 1) accurately delineate aspen stands from other vegetation types;
2) perform a supervised classification that differentiates classes of healthy, damaged, and seral aspen stands; and 3) validate the model using high resolution NAIP aerial photography as an independent validation dataset. As a result of these methodologies, this analysis provided land managers a spatial resource on the location and coverage of aspen stand classes for Cedar Mountain, as well as a resource containing methods applicable to other areas experiencing aspen decline throughout the Colorado Plateau and the Great Basin.

Methods

The study area for this project is located on Cedar Mountain in southern Utah near Cedar City, UT (Fig. 3-1). Cedar Mountain covers approximately 27,216 hectares of mostly privately owned land and is situated within the Kolob Terrace (2,400 - 3,162 m), a broad, relatively flat, lowered southwestern tier of the Markagunt Plateau. Cedar Mountain contains extensive aspen mortality and is among the quintessential SAD examples within the Intermountain West.

Landsat TM imagery was chosen primarily due to its 25-year history of imaging the Earth. Landsat TM offers the longest-running time series of systematic remotely sensed digital data available. While there was no temporal component in this project, the history and systematic coverage of TM data provides the ability to easily apply techniques learned here to other areas. Secondly, the spatial resolution (grain size) of these data tends to fit the requirements for land managers. Thirdly, the spectral resolution of the Landsat TM sensor encompasses important portions of the electromagnetic spectrum (visible, near-infrared [NIR], shortwave-infrared [SWIR]), which are used for
vegetation mapping. Lastly, Landsat TM data are free and can be readily downloaded through the USGS Global Visualizer Viewer (2008).

Landsat TM images can offer repeat imagery every 16 days. However, cloud cover and data quality tend to limit the selection of imagery. Further, phenological variation in the land cover of interest also limits imagery selection. If multiple scenes are needed for a given study area, mosaicking of adjacent Landsat scenes is required. For improved image matching, image standardization for solar angle illumination, instrument calibration, and atmospheric haze (i.e. path radiance) may be necessary.

Predictor layers used to map Cedar Mountain aspen consisted of core image-derived and ancillary datasets (Appendix A). Core image-derived datasets included individual Landsat TM spectral bands (row 38, path 34) from June 26, 2008 and the brightness, greenness, and wetness (BGW) transformation derived from the Landsat TM bands (Crist and Cicone, 1984). Topographic ancillary datasets were extracted from 30-m digital elevation models (DEM) obtained from the Utah Automated Geographic Reference Center (2008) and consisted of slope (in degrees), aspect (moisture index transformation), elevation (m), and a 10-class landform dataset (Manis et al., 2001). The final model integrated a total of 13 predictor layers (Table 3-1).

A key factor of this analysis is selecting aspen stand types, conditions, or classes that are practical from both a remote sensing and management perspective. From a land management standpoint, the aspen stand classification must have ecological relevance in terms of tangible management implications. Understanding this relationship is important in order to effectively create a product that leads to better decisions. From a remote
sensing perspective, aspen stand types must be spectrally distinct enough to separate based on their reflectance characteristics (Table 3-2).

For Cedar Mountain, there are two dominant aspen types, persistent and seral. The persistent type can be divided into healthy and damaged (declining) stand conditions. Healthy stand types are self regenerating stands, usually producing pulses of regeneration that maintain grove size over long periods of time (Bartos, 2001). Healthy aspen stands often contain a pure overstory, good stand structure (i.e. numerous age cohorts), adequate regeneration, and a diverse understory of forb and shrub communities (Mueggler, 1988; Kurzel et al., 2007). These stands tend to be more resilient to disturbance (i.e. insect infestations and disease), invasion by introduced species, and maintain water balance between and within vegetation communities more effectively (Ryel, 2004). Declining aspen stands are characterized by overstory mortality, poor stand structure, weak regeneration, and altered understory communities that weaken stand functionality. The seral stand type is characterized by the presence of aspen and conifers inhabiting the landscape simultaneously. Aspen in these systems are regarded as the early successional, disturbance, or pioneer species since they were generally the first to establish following fire, disease, or other disturbances. Although aspen may continue to persist on conifer-climax sites for many years, potentially centuries, eventually the more shade-tolerant conifers reestablish and begin to break up aspen canopies (Loope, 1971; Schier, 1975). These three aspen types are distinct ecologically and spectrally. Initially, there was interest in separating the “damaged” aspen cover class into multiple cover classes, such as “dead” or “dying.” However, the performance of each of these finer classes proved too difficult to separate with acceptable accuracy. Consequently, they were combined
into the “damaged” class to reduce overall error. However, creating new or splitting classes in other areas may be possible depending on stand characteristics.

Our objective was to classify only aspen into independent stand classes, thus, the inclusion of non-aspen cover was not considered. To identify only areas of aspen, high resolution (1m), color infrared digital orthophoto quarter quads (DOQQs) acquired from the National Agriculture Imagery Program (NAIP) (Utah Automated Geographic Reference Center, 2008) were used to manually delineate aspen cover from non-aspen cover. This process created a general map of aspen (including persistent and seral) with no further separation into different stand classes. The resulting general polygon map of aspen was used to mask out areas that were not aspen. Subsequent digital classification of TM imagery was conducted only within these areas to further segment aspen from non-aspen as well identify the three different stand classes.

One consideration in this technique is that preliminary ground surveying is tremendously helpful. Although the resolution of NAIP is exceptional (1 m), species with similar spectral and textural characteristics to aspen can still be difficult to separate. Ground surveys help resolve areas of uncertainty when delineating aspen stands.

For the Cedar Mountain aspen stand type classification, training and validation data were collected via ground-based field work in the summer of 2008 to match remotely sensed data with peak aspen foliage. Additional aspen stand type data were obtained through visual interpretation of NAIP high resolution aerial photography. Ground based reference data points consisted of 90 x 90 m (approx. 1 ha) plots within a 900 m systematic grid generated in ArcGIS 3.1 (Appendix B). Using the 2,500 m elevation contour as the study boundary, the systematic grid was established within the
aspen woodland and aspen/conifer cover classes from the 2005 Southwest Regional Gap (SWReGAP) landcover project (Fig. 3-4). Each point was verified for contiguous aspen cover (at least 50% aspen or mixed aspen-conifer cover within 90 x 90m plot) using NAIP imagery. Any point not meeting this criterion was discarded from the plot selection process.

A total of 122 training points from the systematic grid were randomly selected and visited during the 2008 summer season and assigned to one of the three aspen stand classes. At each sample point, ocular estimates of overstory canopy cover were collected for cover class designation. The designation of sample points yielded 50, 50, and 22 training points for healthy, damaged, and seral classes, respectively.

Based on previous image classification efforts using Landsat TM imagery (Reese et al., 2002; Lowry et al., 2007), we utilized a Classification and Regression Tree (CART) analysis to produce a spatially explicit discrete classification of aspen stand types for the Cedar Mountain area (Appendix C). Decision tree classifiers (Breiman et al., 1984) are particularly relevant for remote sensing applications as they are non-parametric classifiers, requiring no prior assumptions of normality and readily accepts categorical and continuous datasets.

The mapping procedure utilizing the decision tree classifier is presented in Figure 3-5 for the Cedar Mountain aspen stand classification. Using Erdas Imagine software, the NLCD (National Land-Cover Dataset) mapping tool (Homer et al., 2004) was used to sample the predictor layers (Table 3-1) for each aspen stand type. The training data, therefore, consisted of a data matrix of observations (rows) and variables (columns). The variables consisted of the 13 predictors extracted for each observation and the dependent
variable that categorized each observation into the three aspen stand classes. The
training data matrix was imported into the data-mining, decision tree software See5
(RuleQuest Research, 2004). As a preliminary assessment of map quality, 20% of the
available training data were withheld from the decision tree model generation and used
for validation. These assessments were performed iteratively to find the best
combination of predictor layers for the model. The output land-cover map was compared
with field photos and observations to determine accuracy. Once the final model was
selected based on preliminary accuracy assessments, the final model was generated using
100% of the available training points and predictor layers. The final map was validated
by a systematic 445 point grid using NAIP imagery and visually examined for general
accuracy and distribution of cover classes.

The compilation of an error matrix (i.e. confusion matrix) is considered the
standard form for reporting site-specific errors (Congalton, 1991). An error matrix
identifies the overall accuracy of the image, as well as errors for each category (i.e. user
and producer accuracy). The Kappa (κ) or KHAT statistic was used as a measure of
agreement between model predictions and reality (Congalton, 1991) or to determine if the
values contained in the error matrix represent a result significantly better than random
(Jensen, 1996). If conducted properly (Fig. 3-5), κ values greater than 0.80 (i.e. 80%)
represent strong agreement or accuracy between the classification map and the ground
reference information. κ values between 0.40 and 0.80 indicate moderate agreement and
values less than 0.40 indicate poor agreement.

For the Cedar Mountain study, a rigorous systematic, site-by-site design was
implemented that compared the classified image against high resolution, color infrared
NAIP imagery (reference data) for agreement. To accomplish this task, a 500 m systematic grid was produced within the NAIP-based aspen mask as a preliminary validation set (Appendix D). Each point needed to satisfy the requirement of at least a 50% canopy cover for aspen, the same requirement implemented for the initial 122 points used for model training. Any point that did not satisfy the requirement was removed from the validation set. A total of 445 points satisfied the requirement and were used as the validation/reference dataset (Table 3-4). Once the validation set was established, each of the 445 reference points were classified into one of the three aspen stand classes based on NAIP imagery stand characteristics, field observations, and site photo points. Next, the validation points were superimposed onto the final classification and compared for agreement. From this assessment, an error matrix containing overall validation results (sum of diagonals), user and producer accuracy results, and a KHAT statistic for Cedar Mountain were reported.

Results

The final map product presents the distribution of healthy, damaged, and seral stand types for Cedar Mountain (Figure 3-6) and retains the 30 m pixel resolution consistent with all predictor layer used in the model, with a minimum mapping unit of approximately 0.40 ha (1 acre). Healthy aspen represented the most abundant cover type with an estimated 49% (5,960 ha) of the total aspen cover, followed by damaged aspen 35% (4,210 ha), and seral aspen 19% (1,968 ha) (Table 3-3).

As previously stated, numerous preliminary accuracy assessments (i.e. error matrices) were conducted within the See5 software that utilized 20% of the reference data
to gauge the effectiveness of the model. This procedure was repeated for each model produced until the model of choice was selected based on the best validation results. The See5 generated error matrix for the final model is presented in Table 3-4.

The final model selected utilized all 13 predictor datasets. Subsequently, the final model was re-run utilizing 100% of the training data. The final model was validated using a 445 point, NAIP-based independent accuracy assessment. The overall map accuracy was 81.3% with a kappa of 69% (Table 3-5). Healthy aspen stands received the highest user and producer accuracy (86.3 and 83.3%, respectively). Healthy stands represented the most abundant aspen cover type in both the map estimations (49%) and the proportion of classified validation points (52.5%). From a user’s perspective, healthy aspen stands were most often confused with damaged stands (~ 10% error rate), while in the 3% range with seral stands. The damaged aspen cover class received the next highest user and producer accuracy measure (77.4 and 80.0%, respectively). The user accuracy measures suggest that damaged cover classes was most often confused with healthy stands (18%), and less so with seral stands (4.5%). The confusion between healthy and damaged stands was expected given the ambiguous nature associated with classifying the aspen health gradient. Lastly, the seral cover type received the lowest user and producer accuracy measures (73.4 and 77%, respectively). These findings may largely be due to the paucity of training points (22). Seral stands represented a small portion of the Cedar Mountain landscape (16%), yet exhibited a wide array of stand characteristics that proved difficult to represent in the model. This cover class should receive higher accuracy measures with increased sample points.
Discussion

While remote sensing scientists has been utilizing satellite - based sensors to map land-cover for over 30 years, it has not been until recently that efforts have been made to map aspen ecosystems specifically with regards to aspen decline. This is in part due to both an increased awareness of aspen decline coupled with advances in remote sensing techniques. In this study, remote sensing and GIS methods were developed to assist land managers address the impacts of aspen decline. Cedar Mountain was chosen as the study area as this area exhibits considerable loss of aspen cover in the past decade. Although the Cedar Mountain application was successful, the methodology discussed in this chapter is only one of many viable approaches. Other potential classification methods could include an unsupervised classification (non rule-based) (Jensen, 1996), classification based on spectral mixture analysis (Small, 2001), hybrid unsupervised-supervised classifications, stratification regression models (Pereira and Itami, 1991), and random forests classification (Gislason, 2006). Time, cost, analytical skill, and objectives need to be considered when deciding which classification method to choose. Analytically, the key point to consider is that all land cover classes should be as homogeneous as possible to cut cost and increase accuracy of classification. More importantly, reducing variability within aspen cover classes will only enhance the applicability of the product when used to locate restoration sites.

In this report, an important objective to meet was to develop mapping methods with procedures that could be transferred and independently applied to other areas experiencing aspen decline. In this study, the CART (decision tree) approach was found to be time-efficient and straightforward, making the transferability of information less ambiguous. The output provides a spatial resource that meets the needs of land managers
for Cedar Mountain, but should also work for land managers in other areas with aspen decline.

Although the layers selected (Table 3-1) for the final CART analysis produced an effective model to map aspen stand classes for Cedar Mountain, this selection is not universally applicable. Additional datasets that may also be useful include the Normalized Difference Vegetation Index (NDVI), various soil datasets, and solar radiation derivatives. To further explore options, the application of a Random Forest analysis (Breiman, 2001) can be an informative means to examine variable importance of various datasets, or which predictor layers explain the most variability when using a CART analysis. Simply selecting the major datasets contributing the greatest predictive power into the model may produce the best results. We experimented with various combinations of the predictor data in an effort to create a more parsimonious (simple) model. However, the integration of all 13 predictor layers in the final model was found to be the most accurate.

Additional factors to consider in a classification are the use of core-image (Landsat TM) derivatives and ancillary datasets. For this project, the addition of core-image derivatives (BGW) and ancillary datasets (slope, aspect, and elevation) to supplement core-image multispectral data (Landsat TM) was found to increase classification accuracy. In general, classification techniques using both spectral data and ancillary data have been found to lead to greater overall accuracy, precision, and class distinctions (Trotter, 1991; Jensen, 1996; Lowry et al., 2007).

Lastly, the addition of multi-season or change detection imagery to increase discriminatory power within pure aspen and aspen/conifer (seral) classes has been found
effective in numerous studies (Heide, 2002; Lowry et al., 2007). Aspects to consider when implementing this option is the cost of imagery, availability of specific-multiple dates of cloud free imagery, the inherent effects of elevational gradients and phenology, and snowcover on the image. At the time of the Cedar Mountain aspen stand classification, limited funding and lack of cloud free imagery prevented this project from including multi-season imagery. However, multi-season imagery can capture phenological differences between aspen stands throughout a growing season, potentially providing a valuable dataset to improve the overall product.

Mapping any natural landscape with remotely sensed imagery typically involves capturing large spectral, environmental, and biological diversity associated with the area. This often entails collecting a substantial amount of field samples to properly train and validate output maps. Mapping aspen decline and conifer encroachment into individual cover types is similarly difficult in terms of collecting enough reference samples to account for the complex gradient of health and diversity found in aspen stands.

Sample designs for reference data collection range considerably. Systematic grids, and systematic grids with random sub-sampling of grid points like the one used in this study, provide objective acquisition of samples across the landscape, however, are often subject to under sampling rare cover classes. Totally random sampling designs can also be implemented that are statistically defensible but also tend to under sample rare cover classes. Hybrid designs integrating systematic, random, and stratifying designs all exist. In general, random or stratified random sampling designs generally produce the best results for remote sensing purposes (Congalton, 1988a).

The methods described above to collect reference data for training and validation
is only one of many viable approaches. Ground-based reference data collection generally provides the most reliable option to reduce potential confusion but is often expensive and requires a large amount of time. If funding is limited, utilizing NAIP imagery or other high resolution imagery (i.e. Google Earth) as a surrogate for ground-truthing efforts can yield equally successful results at a fraction of the cost. This is particularly helpful in the development of independent validation datasets (i.e. separate from the training data), as well allow for the complete utilization of training data for model development (Congalton, 1988b). This option, as implemented in the Cedar Mountain application, was very cost effective and provided a thorough means of validating both abundant and rare cover classes and the environmental gradient between. If possible, independent validation datasets should be an integral component of all remote sensing classifications.

As a final note, the task of designing and acquiring unbiased training samples and independent accuracy assessment datasets for most land-cover mapping projects is difficult to achieve, especially so in a project that is focusing on characterizing stand classes within aspen. Improvements to the design and methodologies would contain a sample design that addresses the variation present in the individual, including rare or diverse aspen stands (e.g. damaged and seral aspen). For this project, a random selection within a stratified sampling design based on cover types would likely have increased the performance and accuracy of the model.

The cost to classify an aspen dominated landscape by aspen stand type will vary depending the availability of imagery and quality, remote sensing analyst skill level, computer resources and software licenses, and the level of precision needed to meet
project objectives. Landsat TM data and NAIP imagery for the state of Utah are free of charge to the end user. The taxpayer assumes costs of these data. Other forms of high resolution aerial photography or satellite imagery may or may not have additional fees. If no field-based efforts are implemented, the quality of NAIP imagery must be sufficient to allow photo interpretation or identification of aspen stand type based on the classification scheme. If a field season is included, wages for 1-2 technicians for approximately 1-2 months is expected depending on the size of the study area. Also, depending on skill level and time spent testing and developing methodologies, wages for a remote sensing analyst and possibly a photo interpreter would be expected for 1-3 months. Excluding experimentation with methodologies and techniques for this type of classification, an experienced remote sensing analyst and photo interpreter could complete a similar project in size and scope, including a field season, in approximately 6-8 months.

Conclusion

The objective of this report was to provide remote sensing and GIS methodologies and techniques used to map areas in the Intermountain West experiencing aspen decline. High resolution aerial photography (NAIP imagery), multispectral satellite imagery (Landsat TM), core-image derivatives, and ancillary datasets were used in a CART analysis that successfully mapped three aspen stand types for Cedar Mountain in southern Utah with an overall accuracy of 81.3% using a NAIP-based independent accuracy assessment. To this end, this report can serve land and natural resource managers as a
technical guide for using remote sensing and GIS technologies for aspen monitoring
and restoration activities.

References

Baker, F.S., 1925. Aspen in the central Rocky Mountain Region. USDA Department
Bulletin, Number 1291.

Bartos, D.L., Shepperd, W.D., 2008. Sudden Aspen Decline Summit Report, 12-
13 February 2008. Fort Collins, Colorado: USDA Forest Service. URL:

W.D., Binkley, D., Bartos, K.L., Stohlgren, T.J., Eskew, L.G., (Eds.), Proceedings
of the Symposium on Sustaining Aspen in Western Landscapes (RMRS-P-18),
13-15 June 2000; Grand Junction, CO. USDA, Forest Service. Rocky Mountain
Forest and Range Experiment Station, Fort Collins, CO, pp. 5-14.


Matrices for Assessing the Accuracy Maps Generated from Remotely Sensed
Data. Photogrammetric Engineering and Remote Sensing. 54, 593-600.

Congalton, R. G., 1988b. Using spatial autocorrelation analysis to explore the errors in
maps generated from remotely sensed data. Photogrammetric Engineering and
Remote Sensing. 54, 587-592.


Heide, S.C., 2002. Comparison of methods to detect conifer encroachment into aspen
stands using Landsat 7 ETM+ satellite imagery. M.S. Thesis. University of Idaho,
Moscow, Idaho.


multiseasonal Landsat TM data: A retrospective of the WISCLAND project. Remote sensing of Environment. 82, 224-237.


Table 3-1. The 13 predictor layers used in aspen classification model.

<table>
<thead>
<tr>
<th>Model Input</th>
<th>Band #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Landsat TM 5 refl.</td>
<td>Band 1</td>
<td>Blue</td>
</tr>
<tr>
<td>Landsat TM 5 refl.</td>
<td>Band 2</td>
<td>Green</td>
</tr>
<tr>
<td>Landsat TM 5 refl.</td>
<td>Band 3</td>
<td>Red</td>
</tr>
<tr>
<td>Landsat TM 5 refl.</td>
<td>Band 4</td>
<td>NIR</td>
</tr>
<tr>
<td>Landsat TM 5 refl.</td>
<td>Band 5</td>
<td>MIR</td>
</tr>
<tr>
<td>Landsat TM 5 refl.</td>
<td>Band 6</td>
<td>MIR</td>
</tr>
<tr>
<td>Core-image derivative</td>
<td>Band 7</td>
<td>Brightness</td>
</tr>
<tr>
<td>Core-image derivative</td>
<td>Band 8</td>
<td>Greenness</td>
</tr>
<tr>
<td>Core-image derivative</td>
<td>Band 9</td>
<td>Wetness</td>
</tr>
<tr>
<td>DEM</td>
<td>Band 10</td>
<td>Elevation</td>
</tr>
<tr>
<td>DEM</td>
<td>Band 11</td>
<td>Slope</td>
</tr>
<tr>
<td>DEM</td>
<td>Band 12</td>
<td>Aspect</td>
</tr>
<tr>
<td>Landform</td>
<td>Band 13</td>
<td>Landform</td>
</tr>
</tbody>
</table>

Table 3-2. Description of aspen stand types used for Cedar Mountain classification.

**Healthy**  
Full aspen crowns with little to no die-off (< 25% overstory mortality, < 25% conifer cover)

**Damaged**  
Dead or dying aspen stands with considerable to full overstory die-off and/or foliage loss (25-100% overstory mortality, < 25% conifer cover)

**Seral**  
Presence of aspen and at least 25% conifer cover within the plot

*Note: Condition based on 90 x 90m plot observation.*

Table 3-3. Gradient of pixels, hectares, and percentage classified for each stand class.

<table>
<thead>
<tr>
<th>Aspen cover class</th>
<th># of pixels</th>
<th>Area (ha)</th>
<th>% aspen cover</th>
</tr>
</thead>
<tbody>
<tr>
<td>Healthy</td>
<td>66,230</td>
<td>5,960</td>
<td>49</td>
</tr>
<tr>
<td>Damaged</td>
<td>46,783</td>
<td>4,210</td>
<td>35</td>
</tr>
<tr>
<td>Seral</td>
<td>21,875</td>
<td>1,968</td>
<td>16</td>
</tr>
</tbody>
</table>
Table 3-4. Error matrix generated in See5 utilizing 20% of training/reference data.

<table>
<thead>
<tr>
<th>Reference Data</th>
<th>Healthy</th>
<th>Damaged</th>
<th>Seral</th>
<th>Totals</th>
<th>UA%</th>
<th>CE%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Healthy</td>
<td>9</td>
<td>0</td>
<td>2</td>
<td>11</td>
<td>81.8</td>
<td>18.2</td>
</tr>
<tr>
<td>Damaged</td>
<td>2</td>
<td>6</td>
<td>1</td>
<td>9</td>
<td>66.7</td>
<td>33.3</td>
</tr>
<tr>
<td>Seral</td>
<td>1</td>
<td>0</td>
<td>6</td>
<td>7</td>
<td>85.7</td>
<td>14.3</td>
</tr>
<tr>
<td>Totals</td>
<td>12</td>
<td>6</td>
<td>9</td>
<td>27</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PA%</td>
<td>75.0</td>
<td>100.0</td>
<td>66.7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EO%</td>
<td>25.0</td>
<td>0.0</td>
<td>33.3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overall err.</td>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td>22.3%</td>
<td></td>
</tr>
<tr>
<td>Overall Accuracy</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>77.8%</td>
<td></td>
</tr>
</tbody>
</table>

Note: UA, user's accuracy; PA, producer's accuracy; EO, errors of omission, CE, errors of commission.

Table 3-5. Error matrix for Cedar Mountain aspen stand classification.

<table>
<thead>
<tr>
<th>Reference Data</th>
<th>Healthy</th>
<th>Damaged</th>
<th>Seral</th>
<th>Totals</th>
<th>UA%</th>
<th>CE%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Healthy</td>
<td>195</td>
<td>24</td>
<td>7</td>
<td>226</td>
<td>86.3</td>
<td>13.7</td>
</tr>
<tr>
<td>Damaged</td>
<td>28</td>
<td>120</td>
<td>7</td>
<td>155</td>
<td>77.4</td>
<td>22.6</td>
</tr>
<tr>
<td>Seral</td>
<td>11</td>
<td>6</td>
<td>47</td>
<td>64</td>
<td>73.4</td>
<td>26.6</td>
</tr>
<tr>
<td>Totals</td>
<td>234</td>
<td>150</td>
<td>61</td>
<td>362</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PA%</td>
<td>83.3</td>
<td>80.0</td>
<td>77.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EO%</td>
<td>16.7</td>
<td>20.0</td>
<td>23.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overall err.</td>
<td>83</td>
<td></td>
<td></td>
<td></td>
<td>18.7%</td>
<td></td>
</tr>
<tr>
<td>Overall Accuracy</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>81.3%</td>
<td></td>
</tr>
<tr>
<td>KHAT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>69%</td>
<td></td>
</tr>
</tbody>
</table>

Note: UA, user's accuracy; PA, producer's accuracy; EO, errors of omission, CE, errors of commission.
Figure 3-1. The Cedar Mountain, Utah study area.
Figure 3-2. Un-delineated portion of a NAIP image.

Figure 3-3. Aspen delineated in portion of a NAIP image.
Figure 3-4. Map of the Cedar Mountain, UT study area with training data systematically overlaying the aspen cover mask.
Figure 3-5. General mapping process for the aspen stand type classification.
Figure 3-6. Final aspen stand type classification map containing three mapped classes for the Cedar Mountain study area.
CHAPTER 4
RAPID MORTALITY OF *POPULUS TREMULOIDES* ON
CEDAR MOUNTAIN IN SOUTHERN UTAH

Abstract

Aspen (*Populus tremuloides* Michx.) is an ecologically, commercially, and aesthetically important species in the western United States. However, widespread decline of quaking aspen is occurring throughout its range in the Intermountain West since European settlement. On Cedar Mountain in southern Utah, concern about mortality of aspen has increased in the past decade. This study presents a spatially explicit 2008 landscape assessment of aspen mortality on Cedar Mountain using remote sensing and GIS techniques. The primary objectives of this study were to develop a suitable remote sensing approach for assessing aspen decline across western landscapes and apply this approach to quantify current aspen condition on Cedar Mountain. Classification and Regression Tree (CART) analysis, multi-spectral imagery, digital elevation models (DEM), and ancillary biophysical data were used to generate a spatially explicit aspen stand type classification for the study area. More specifically, the analysis developed an aspen stand map composed of three classes: two persistent aspen stand conditions (healthy and damaged), and an additional aspen stand type (seral). In addition, an analysis was conducted on predisposing landscape metrics (i.e., slope, aspect, elevation) in relation to aspen stand class for the Cedar Mountain landscape.

Damaged (dead and dying) stands composed 35.0% (4,210 ha) of the Cedar Mountain aspen cover type. Healthy and seral aspen stands composed 49.0% (5,960 ha)
and 16.0% (1,968 ha), respectively. Validation measures yielded an overall accuracy measure of 81.3% (KHAT=.69, n = 445). For the Cedar Mountain study area, statistical analyses indicated that damaged stands were found primarily at lower elevations on south-to-west aspects, the mean elevation of damaged stands (2,708 m) was lower than that of the mean elevation of healthy aspen stands (2,754 m), and the frequency of damaged stands primarily was higher on drier aspects. Slope was not found to be related to the aspen classes in the analysis.

Introduction

Quaking aspen (Populus tremuloides Michx.) is the most widespread deciduous tree species in North America and on western landscapes is noted for biodiversity, productivity, hydrological assets, and aesthetics (Preston, 1976; Kay, 1997; Bartos, 2001; LaMalfa and Ryel, 2008). Despite its apparent value, aspen communities in portions of the Intermountain Region of western United States are in evident decline, with certain areas experiencing rapid mortality events within the past decade (Worrall et al., 2008). Among the factors contributing to aspen decline, Holocene climatic change (Baker, 1925; Maini, 1968) and 20th century fire suppression leading to conifer succession have received considerable attention (Baker, 1925; Schier, 1975; Jones and DeBye, 1985), as has the overgrazing of regeneration via domestic and wildlife ungulates (White et al., 1998; Bartos, 2001; Ripple and Larsen, 2001; Sexton et al. 2006) and the impacts of disease and insect outbreaks on stressed aspen stands (Hogg and Schwarz, 1999; Worrall et al., 2008). The recent accounts of rapid mortality in the southern Rocky Mountains have striking similarities in their relative suddenness and severity, characteristically
different than the gradual stand deterioration (10-20 yrs) that is more typical of aspen in some areas (Sinclair and Lyon, 2005). Furthermore, severely deteriorating stands are exhibiting poor regeneration, with many affected areas containing inadequate suckering to maintain aspen persistence on the landscape (Worrall et al., 2008). Under these conditions and without large scale disturbance to actively induce suckering, advancing conifer encroachment and or other plant community types will replace aspen forests through succession or replacement.

In the past few decades, the relationship between a century of fire exclusion and intense over-browsing, advancing conifer succession, and changing climatic factors has been captured in numerous aspen mortality studies that document uncharacteristic patterns of decline and severity. In Canada, high mean annual temperatures in the northern Great Lakes region during the 1970s were found to contribute to widespread aspen decline of mature, open stands (Shields and Bockheim, 1981). Also in Canada, numerous Prairie Provinces experienced substantial mortality and growth loss of aspen during the late 1980s and early 1990s due to drought followed by an outbreak of insect defoliators for the region (Brandt et al., 2003). In the Intermountain West of the United States, Orio et al. (2005) examined aspen in northern California and found a 24% decline of aspen cover over a 48-year period. Rogers (2002) examined USDA Forest Service Forest Health Monitoring (FHM) data from Idaho, Wyoming, and Colorado and linked advancing conifer succession and fire suppression to a century of aspen decline. During the 1970s, similar factors were believed to be related to a widespread deterioration of aspen in the Intermountain West, specifically Utah and western Wyoming (Schier, 1975). Over the past 50 years, most studies documenting aspen decline linked increased
warming trends and drought conditions with increased rates of decline. In the light of climate change, moisture related aspen decline is expected to continue with longer warming trends coupled with low precipitation regimes projected for the Intermountain West.

More recently, unusual events of rapid aspen mortality have been reported in southwestern Colorado (Worrall et al., 2008), northern Arizona (M.L. Fairweather, personal communication), Montana (W.D. Sheppard, unpublished observations), and southern Utah, including Cedar Mountain in southwestern Utah (J. Bowns, personal communication). The apparent rapid, synchronized, and widespread nature of these events has raised the concern among landowners and resource managers alike. Critical natural amenities (hydrological, ecological, and aesthetic values) are declining with the continued loss of aspen from the Intermountain West.

Realizing the implications aspen decline has on natural resources, land and resource managers need detailed spatial information on the location, extent, and magnitude of declining aspen stands to properly assess aspen condition over large areas throughout the Intermountain West. Toward this need, this study conducted a spatially explicit landscape analysis of the current condition of aspen on Cedar Mountain using remote sensing and GIS techniques. The objectives of this study were: 1) to develop a suitable remote sensing approach for assessing aspen decline across western landscapes and 2) to apply this approach to quantify current aspen condition on Cedar Mountain.
Study area

The study area (Fig. 4-1) is located on Cedar Mountain near the boundaries of Iron, Washington, and Kane counties in Southern Utah, approximately 12 kilometers southeast of Cedar City, Utah. The Cedar Mountain study area is 27,216 ha and is situated within the Kolob Terrace, a broad, relatively flat, lowered southwestern tier of the Markagunt Plateau within the Southern Rocky Mountains Ecoregion Province. Within the Ecoregion framework (McNab and Avers, 1994; Bailey, 1998), the Kolob Terrace is bounded to the north and northeast by the western rim of the Markagunt Plateau, while its western side descends abruptly into the southeastern portions of the Great Basin. The southern boundary descends into the canyons of northern Zion National Park and surrounding areas of the Colorado Plateau.

The study area lies between 2,400 and 3,162 m elevation, with slopes ranging from 0% to 28%. Mean annual precipitation for the study area between 1971 and 2000 was approximately 864 mm yr⁻¹, which is often expressed in a moderately bimodal seasonal trend, mainly as winter snowfall and summer monsoonal rains (Table 4-1). The monthly mean temperatures for Cedar Mountain ranged between -3° C and 20° C, with an average annual maximum temperature of 8.39 ° C (Table 4-1). Soils within the study area are predominantly Argic Pachic Cryborolls, fine montmorillonitic faim clay loam derived from igneous parent materials (Bowns and Bagley, 1986).

Much of Cedar Mountain is capped with volcanic flow basalt, deriving soils that are consistent with the *Populus tremuloides* / *Carex rossii* and *Populus tremuloides* / *Symphoricarpos oreophilus*/Tall Forb community type (Mueggler, 1988). Persistent aspen forests comprise the primary hardwood element within the study area and are
broadly found on minor northwest- to south-, and south- to northeast- facing slopes. More rarely, where ridges terminate into canyon bottoms or tiered features within the study area, aspen persist in small patches or “stringers” along the peripheral ridges, tiers, and drainages. Mixed aspen and conifer stands appear to be prevalent on steeper and north- to northeastern- slopes. Upland, broader ridges and canyon bottoms are comprised of sagebrush (*Artemisia tridentata*) with numerous understory graminoid and herbaceous species. The lower elevation ridges and drier canyon sites were populated with patches of mountain snowberry (*Symphoricarpos oreophilus* Gray) and Gambel oak (*Quercus gambelii* Nutt.). On the southern portions of the study area, Gambel oak accounts for the dominate canopy cover on southeast- to west-facing lower elevation slopes.

The northern portions of the study area exhibit higher elevations with steep slopes into Cedar Canyon proper and into the lower portion of the Markagunt Plateau near Cedar Breaks National Monument. These northwest- to northeast- facing, higher elevation slopes generally are dominated by mixed aspen/conifer (seral) and pure conifer communities. Conifers present on these landforms consisted of Engelmann spruce (*Picea engelmannii* Parry), subalpine fir (*Abies lasiocarpa* Nutt.), white fir (*Abies concolor*) and Douglas fir (*Psuedotsuga menziesii* Mirb).

Cedar Mountain is predominately privately owned with small pockets near the north- eastern boundary of the study area being federally managed within the Dixie National Forest. Coinciding with over a century of fire suppression and intense domestic grazing on both the private and federal sectors, has been a change in understory vegetation from a community dominated by tall forbs to the present graminoid community (Bowns and Bagley, 1986).
The area of interest used for plot selection utilized the aspen woodland and aspen/conifer cover types from the 2005 Southwest Regional Gap (SWReGAP) land cover project for the Cedar Mountain area (USGS National Gap Analysis Program, 2004). Using a 2,500 m elevation boundary, a 900 m systematic grid was established within the aspen cover types and verified for contiguous aspen cover stand using 2006 NAIP 1-m digital ortho photography (Utah Automated Geographic Reference Center, 2008). Points not meeting a criterion of at least 50% aspen or mixed aspen-conifer cover within a 90 x 90 m contiguous area were discarded. A random selection of sampling points resulted in a total of 122 training points.

Reconnaissance and ground-truthing work was performed for each training point in July and August of 2008 to match remotely sensed data with peak aspen foliage. Each sample point was assigned to one of three aspen stand classes based on perceived stand characteristics within a 90 by 90 m area surrounding the sampling point. The three aspen stand classes encompass two broad ecological aspen types: persistent and seral. Persistent stand types are composed of two general conditions, healthy and damaged (declining) stand types. Healthy aspen stands maintain persistence over time, often containing pure overstories, good stand structure (i.e., numerous age cohorts), adequate regeneration, and diverse understory forb and shrub communities (Mueggler, 1989; Bartos, 2001; Kurzel et al., 2007). Declining aspen stands are characterized by overstory mortality, poor stand structure, weak regeneration, and altered understory communities. Lastly, seral stand types are defined by the presence of aspen and conifers inhabiting the landscape simultaneously. Based on these stand characteristics and the capabilities inherent in remote sensing technology, three aspen classes were selected: “Healthy” for
stable, regenerating aspen stands, “Damaged” for declining aspen stands, and “Seral” for the successional aspen stand type. Field ground-truthing efforts resulted in 50, 50, and 22 training points for healthy, damaged, and seral aspen stand classes, respectively (Fig. 4-2). This classification scheme was used to train 2008 Landsat Thematic Mapper (TM) imagery into the three distinct aspen stand classes. Given the capabilities of Landsat TM imagery, the three aspen stand classes that were chosen offered the highest overall map accuracy and delineated aspen stand condition useful to land managers on Cedar Mountain.

Methods on vegetative classifications based on ecological relationships using remotely-sensed imagery vary considerably. Based on previous vegetative classification efforts using moderate scale Landsat TM remotely sensed data (Reese et al., 2002; Lowry et al., 2007), a similar method was derived for this study with the assumption that Landsat TM imagery could be used in a Classification and Regression Tree (CART) analysis to produce a spatially explicit discrete classification of aspen stand types for the Cedar Mountain area. Multispectral, core-image derivatives, and ancillary datasets were combined in a supervised classification algorithm that resulted in spectrally unique signatures for each aspen stand class.

Data

Pre-processed, cloud-free, Landsat TM reflectance data (row 38, path 34) was acquired from the USGS Global Visualizer (2008) for June 26, 2008 and subsequently reprojected using the North American Datum 1983 UTM Zone 12N and nearest neighbor resampling intensity. Several combinations of Landsat TM reflectance data and tassel
cap transformations (brightness, greenness, and wetness (BGW)) were used in conjunction with topographic ancillary data (topographic layers: slope, aspect, elevation) extracted from a 30 m digital elevation model (DEM) (Utah Automated Geographic Reference Center, 2008) and a 30 m Land Form layer (Manis et al., 2001) as predictor layers in the classification model using CART analysis (Table 4-2).

The final model integrated a total of 13 predictor layers (bands) into the CART model using the 122 sample points as the training source (dependent variable). The predictor layers chosen were based on ecological and reflective properties that best explain environmental variability within aspen systems. The core Landsat TM image provided six spectral bands, including bands three (i.e. “red”, 0.630-0.690 μm), and four (i.e. “near infrared”, 0.750-0.900 μm) that are highly sensitive to persistent-leaved vegetation canopy cover. TM bands 1, 2, and 3 correspond to the blue (0.450-0.515 μm), green (0.525-0.605 μm), and red (0.630-0.690 μm) spectra of absorption for photosynthesizing vegetative material (Jensen, 1996).

The tassel cap transformations brightness, greenness, and wetness (BGW) derived from the core Landsat TM bands offer spectral datasets that capture vegetative attributes related to vegetative and moisture conditions (Jensen, 1996). The usage of the BGW derivative was based on the assumption that a lack of vegetation associated with damaged (dead/dying) stands would illustrate lower greenness and wetness values, while the opposite would hold true for healthy stands. Furthermore, coniferous canopy cover found in seral stands would illustrate lower brightness and greenness values relative to pure, persistent aspen stands.

The ancillary datasets used in the model (Fig. 4-3) were derived from 30-m digital
elevation models (DEM), consisting of slope (in degrees), elevation, aspect (moisture index), and a 10-class landform dataset (see Manis et al. (2001) for a detailed description of landform dataset). Since aspect values cannot be averaged (e.g., 340° and 10°), a moisture index transformation was derived from aspect for the study area and was calculated similarly as \((1 + \cos(\text{aspect-30°}))/2\). The moisture index assigned contiguous values from zero to one, with zero representing driest conditions (210°) and one representing wettest conditions (30°).

A decision tree classifier method of analysis (CART) was applied based on its recent improvement in accuracy using moderate-scale Landsat TM imagery for remotely sensed land-cover classifications (Pal and Mather, 2003; Lawrence et al., 2004; Lowry et al., 2007). Decision tree classifiers (Breiman et al., 1984) are particularly relevant for remote sensing applications as they are non-parametric classifiers, requiring no prior assumptions of normality (training data). Furthermore, CART analyses readily accept categorical and continuous datasets that have resulted in increased accuracy relative to traditional parametric classifiers (Pal and Mather, 2003).

The modeling approach using the decision tree classifier is presented in Figure 4-4 for the Cedar Mountain aspen stand classification. Once the 13 predictor layers used to classify the aspen health classes (Table 4-2) were prepared for the study area, the data were compiled into training and sample data to conduct the supervised classification (1, 2). Using Erdas Imagine software, the NLCD (National Land-Cover Dataset) mapping tool (Homer et al., 2004) was used to create specific datasets comprised of all predictor layers (Table 4-1) for each aspen health cover class. The datasets for each aspen health cover class were integrated into the decision tree software See5 (RuleQuest Research,
2004) (3). As a preliminary assessment of map quality, 20% of the available training
data were withheld from the decision tree model generation (4). These assessments were
performed iteratively to find the best combination of predictor layers for the model. The
land-cover map was examined for general accuracy, compared with field photos and
observations, and an error matrix was produced and evaluated. The final decision tree
model and map was generated from 100% of the available training points and predictor
layers (5), and masked by a 12,139 hectare digitized delineation of aspen cover based on
2006 NAIP (National Agricultural Imagery Program) 1-m digital ortho photography
(Utah Automated Geographic Reference Center, 2008) to reduce non-aspen cover from
the analysis. The final map was validated by a systematic 445-point grid using NAIP
imagery (6). A NAIP-based validation sample point was considered correct when the
classification aspen stand type designation agreed with the validation sample point. The
final map was examined for errors and visually inspected for any discrepancies. An error
matrix was generated and the KHAT statistic (Congalton and Green, 1999) calculated to
examine overall model performance.

In southern Utah, quaking aspen range in elevation from 2,400 to 3,100m, a
distinct high elevation/latitude (37.5° - 39°) relationship found uniquely on the Kolob
Terrace of the Markagunt Plateau within the Dixie National Forests and surrounding
areas (Mueggler, 1988). Given the position of Cedar Mountain in southern Utah and the
recent drought for the region (J. Bowns, personal communication), moisture related
physiological stress is hypothesized to be linked to the recent rapid mortality of aspen
throughout the region. Since the low elevation boundaries of many species are
influenced by moisture limitations, long durations of drought and warm temperatures
may have the most pronounced effects at low elevations (Stage and Salas, 2007).
Landscape characteristics such as steep slope, southerly aspect, and low elevation, may
further render certain aspen stands within the region more susceptible to this form of
decline. Within the Cedar Mountain study area, topographic ancillary data (slope, aspect
(moisture index), and elevation) were derived from a 10-m DEM (Utah Automated
Geographic Reference Center, 2008), mosaicked, and subset for the study area. For each
of the 122 sample points used in the classification, a 1 ha buffer polygon was placed
around each sample point to calculate averages on each ancillary topographic layer.
These averages were calculated for each sample point. Once the topographic attributes
for each sample point were established, the sample points were assigned their respective
classes (healthy, damaged, and seral), and a 1-way analysis of variance (ANOVA) was
conducted to test for differences between classes.

Validation

The CART model was validated against 13 CIR (color-infrared) NAIP images for
the Cedar Mountain study area. Since CIR NAIP imagery captures photosynthetic
material exceptionally well, deciphering different aspen stand types based on spectral
characteristics was straightforward. A 500 m systematic grid was produced within the
NAIP-based aspen mask as a preliminary validation set. Each point was examined and
needed to satisfy the requirement of at least a 50% canopy cover requirement, the same
requirement implemented for the initial 122 points used for field sampling. Any point
that did not satisfy the requirement was removed from the validation set. A total of 445
points satisfied the requirement and was thus used as the validation dataset.
The validation process was conducted in two phases. First, each of the 445 validation points were classified into one of the three aspen stand classes based on CIR NAIP imagery stand characteristics. Once all points were classified, the aspen stand classification was compared to assess agreement between map and validation dataset. Based on the comparison, an error matrix and KHAT statistic were calculated (Table 4-4).

Results

A final map product was constructed that contained the three aspen stand classes (Fig. 4-5). The aspen stand cover class dataset for the area retains the 30 m pixel resolution consistent with all predictor layer used in the model, with a minimum mapping unit of approximately 0.40 ha (1 acre). The Cedar Mountain study area represents a 27,216 ha area with the primary categorization of aspen within the delineated aspen mask for a total area of 12,139 ha. Healthy aspen represented the most abundant cover class with an estimated 49% (5,960 ha) of the total aspen cover, followed by damaged aspen 35% (4,210 ha), and seral aspen 19% (1,968 ha) (Table 4-3).

Overall validation results (sum of diagonals), modeled aspen cover classes, validation sample size, user and producer accuracy results, and KHAT statistic for the Cedar Mountain study area are reported in Table 4-4.

A total of 362 of 445 sample points were correctly classified against validated sample points. Healthy aspen stands received the highest user and producer accuracy measures (86.3 and 83.3%, respectively). Healthy stands represented the most abundant aspen cover type in both the map estimations (49.0%) and the proportion of classified
validation points (52.5%). From a user’s perspective, healthy aspen stands were most often confused with damaged stands with ~ 10% misclassification rate, while misclassification as seral was lower (3.0%). The damaged aspen cover class received the next highest user and producer accuracy measure (77.4 and 80.0%, respectively). The user accuracy measures suggest that damaged cover class was most often confused with healthy stands (18.0%), and less so with seral stands (4.5%). The confusion between healthy and damaged stands was expected given the ambiguous nature associated with classifying the aspen health gradient. Lastly, the seral cover type received the lowest user and producer accuracy measures (73.4 and 77.0%, respectively), and may relate to the paucity of training points (22). Seral stands represented a small portion of the Cedar Mountain landscape (19%), yet exhibited a wide array of stand characteristics that proved difficult to represent in the model. This cover class undoubtedly would receive higher accuracy measures with increased sample points. The three aspen stand classes that were validated represent ~100% of the total aspen cover for Cedar Mountain, with an overall accuracy measure of 81.3% (KHAT statistic = 0.69, n = 445).

Across the Cedar Mountain study area, 4,210 ha were classified as “damaged” based on the 2008 aspen stand classification (Table 4-3). This cover class represents concentrated areas of recent aspen decline not presently linked to a known causal agent, and accounts for approximately 35% of the total aspen cover on Cedar Mountain in 2008. In general, aspen mortality on Cedar Mountain was most common on the central and northeastern portions of the study area (Fig. 4-5). The most severe damage was on the middle plateau that extends southeasterly where the majority of the aspen cover was affected. Cover class analysis is not
available outside the 2,500 m boundary, but observations suggest additional damage on these low elevation sites, many of which are more severe than within the study area.

For the Cedar Mountain study area, landscape metrics for the three stand classes were significantly different (Table 4-5, Fig. 4-6). Elevation was found to be significantly different among all aspen stand classes. Damaged stands were found primarily at lower elevations. Within the aspen elevation range, the mean elevation of damaged stands (2,708 m) was lower than that of the mean elevation of healthy stands (2,754 m), suggesting increasing mortality with decreasing elevation. Aspect (moisture index) was also significant between healthy and damaged stands. Damaged stands were found primarily on southern aspects, while healthy stands were more uniformly distributed with a higher abundance on northerly sites. Damaged sites at low and mid elevations tended to be on south to west aspects, with the mean aspect more southerly than that of healthy aspen. Slope between healthy and damaged stand classes was not found to be significant (p = 0.96). Mean slopes between the stand classes were similar, and slope did not appear to be a driving factor in the aspen mortality on Cedar Mountain. The seral cover class was less frequently sampled than healthy and damaged cover classes, yet was found to be significantly different in elevation and slope. The majority of the seral stands sampled were on steep slopes at lower elevations. This is largely due to conifer species ability to establish on steep, moist landscape positions.

Discussion

An estimated 35% of the total aspen cover on Cedar Mountain in southern Utah in June 2008 contains damaged aspen stands composed of dead and dying aspen stands.
These results are consistent with and compliment the field observations from landowners and managers (J. Bowns, personal communication) that suggest this mortality event occurred extensively within the past decade. These findings have striking similarities to the rapid and synchronized mortality events reported in southwestern Colorado (Worrall et al., 2008) and northern Arizona (M.L. Fairweather, personal communication).

In the past decade, the Cedar Mountain area has experienced drought conditions with extended durations of warm temperatures (Jim Bowns, personal communications). Extensive aspen mortality events on Cedar Mountain appear to be influenced by landscape metrics that constrain water balance over the growing season. Over the area where most aspen occurred, the proportion of damaged aspen was greatest at lower elevations where lower moisture availability is most pronounced and air temperatures and vapor pressure deficits are higher. These findings are similar to those of Worrall et al. (2008) in the San Juan Mountains of southwest Colorado. This pattern suggests drought and warmer temperatures may be related to the extensive mortality event over the decade.

Aspect was also found to be significantly different between cover classes. The majority of damaged aspen stands analyzed averaged lower moisture indices than healthy stands, signifying that damaged stands tended to have more southerly exposure, compared to the northern, more mesic healthy stands. Southern aspects receive more solar radiation than northerly sites, thus they receive longer durations of warm temperatures and have greater evapotranspiration rates, rendering aspen stands more susceptible to water-related physiological stress.

Although slope has been related to previous documented aspen decline events
(Allen and Breshears, 1998; Worrall et al., 2008), in this study, slope was not found to be significantly different between condition classes of persistent aspen. This may be explained by the generally flat topography on Cedar Mountain and the greater Kolob Terrace. Most persistent aspen occurred on relatively flat slopes, with seral being more prevalent on steep, north facing slopes found primarily on the northern portion of the study area. These ecosites contained cool, wet conditions conducive for succession to conifers (Johnston and Huckaby, 2001). Worrall et al. (2008) found that the incidence of mortality was higher on less steep slopes than healthy aspen, and suggested shallower roots found on flat ecosites were more susceptible to drought induced decline. A larger study area may have revealed a better relationship between slope and mortality.

Several field observations suggest a link between management, water-related physiological stress, and the recent drought. Much of the Cedar Mountain aspen is positioned on a basalt cap that spreads the breadth of the study area. Soils derived from basaltic bedrock are notoriously drought prone since they drain quickly. Coupled with low precipitation in some years and the historical grazing regimes for the region, the understory communities have changed from native tall forb communities to introduced grass communities (Jim Bowns, personal communications). Under these conditions, understory communities do not retain or redistribute water effectively, nor serve as a buffer for aspen systems against abiotic disturbances such as drought. Furthermore, aspen located on susceptible landscape positions (e.g., low elevation, southerly aspects) are prone to decline due to higher evapotranspiration rates and excessive drainage via drought prone soils.

These conditions are often exacerbated by the populations of both native and
domestic ungulates browsing on aspen regeneration that continually reduce root carbohydrate reserves. As a result, many stands throughout the study area contained very large trees with minimal understory and regeneration cover. Much of Cedar Mountain has not experienced fire in the past 160 years since European settlement, likely contributing to the dominance of large, older trees with few younger cohorts and regeneration pulses. With many sites containing large trees (> 120 years old), water demands per tree are very high, and during times of drought, large trees representing the largest biomass source would likely be the first to succumb to drought-induced decline.

Furthermore, many damaged areas containing large trees have been linked to root moribund (Sheppard et al., 2001). If trends of root decay and other diseases continue to kill roots, aspen stands will not be able to regenerate and will not persist on site.

Mortality related to biotic agents was not thoroughly examined in this study, however, a suite of biotic agents associated with mortality on Cedar Mountain were noticed in field observations. In sparse stands with older age trees, *Armillaria* spp. root disease and *Phellinus* spp. accounted for significant losses, especially in exposed, open sites prone to windthrow. Also, numerous canker pathogens, such as sooty-bark and *Cytospora* spp. cankers were noticed in isolated patches. Stem cankers present were *Ceratocystis* spp. and *Cryptosphaeria* spp. (Hinds, 1985). None of these were prevalent throughout all mortality areas, but were present in varying degrees depending on the severity and maturity of decline within a stand. Further research is needed to clarify each species impact on the recent aspen mortality and whether these biotic agents are related to the occurrence of drought-related stress or act independently.

While the remote sensing sciences has been utilizing satellite-based sensors to
map land-cover for over 30 years, it has not been until recently that efforts have been made to map aspen ecosystems specifically with regards to aspen decline. This is in part due to both an increased awareness of aspen decline coupled with advances in remote sensing techniques. As satellite imagery from numerous sensors (e.g., Landsat, SPOT, IKONOS, MODIS) becomes more available, as well as with increased computing and processing power, scientists and land managers alike will develop better techniques to map aspen systems. In the near future, high spatial resolution and spectrally diverse forms of imagery will be coupled with refined image classification methods and processing software to produce aspen classification maps, including persistent, seral, and declining classes of aspen systems. Heide (2002) used Landsat 7 ETM+ data to classify pure aspen and three classes of seral aspen with moderate success. Strand et al. (2009) also used Landsat 7 ETM+ and mapped pure aspen successfully and numerous aspen/conifer mixtures with moderate to low accuracy measures. Although Landsat 7 ETM+ imagery was not available for this project, 2008 Landsat TM data were used in conjunction with topographic and core-image derivatives in a decision tree approach (CART) to map three aspen stand classes successfully on Cedar Mountain.

In this classification, all three aspen stand classes (healthy, damaged, seral) received good to moderate accuracy measures. However, similar to other aspen classification efforts, the seral cover class proved to be the most difficult to classify correctly. Both producer and user accuracy measures for seral never broke the standard 80% accuracy barrier. Many factors affect the accuracy of seral cover classes, including standard georegistration errors associated with using imagery and GPS units, conifer canopy cover assessments (overstory and understory) in the field, shading effects of
aspen on steep slopes, and the inherent difficulty of identifying the source of radiance within an individual pixel (Cracknell, 1998). Methodologically, the paucity of seral training points (22) may insufficiently represent the environmental and spectral variability within this rarer class. This was an artifact of selecting points using a systematic grid. In the northeastern portion, a number of areas with sparse aspen cover and no conifer cover were commonly being classified as seral. Coincidently, numerous seral training sites with sparse aspen cover did occur in this region of the study area, potentially influencing the decision tree to construct a liberal classification range for this cover type.

Healthy and damaged aspen stand types represented the most abundant cover types, and were equally represented (50 each) in training points. Healthy and damaged stand types maintained user and producer accuracy measures between 77% and 86%. These results were expected given the complex gradient of health characteristics among and between aspen stand types. One of the primary objectives of the study was to map areas of Cedar Mountain illustrating rapid mortality. However, numerous environmental factors associated with damaged stands confounded the spectral integrity of this cover class. For example, low profile vegetation, such as young cohorts of aspen regeneration, shrubs, and the Gambel oak were occasionally classified as damaged aspen (Sexton et al., 2006). Also in the northeastern portion, sparse areas of healthy aspen cover were occasionally classified as damaged aspen. The result was a slight over estimation of damaged aspen and an under estimation of healthy aspen for the study area. Since healthy and damaged cover classes represent the most coverage, error associated with these cover classes account for the majority of the overall error in the model itself.
To address the liberal classification of damaged aspen, thirteen CIR NAIP 1-m aerial photography scenes were used to manually delineate an aspen cover layer. This procedure offered several advantages. First, the high resolution aerial photography provided a powerful ground-truthing tool to decipher other vegetation types that may be confused with aspen. On Cedar Mountain, Gambel Oak (*Quercus gambelii* Nutt.) was a common broadleaf mountain shrub species (among others) that proved very difficult to spectrally separate from aspen (Sexton et al., 2006; Strand, 2007). By delineating strictly aspen, the majority of the error associated with classifying non-aspen cover was reduced. Also, the manual delineated aspen layer provided a continuous gradient of aspen health rather than discrete pre-defined classes often implemented in stratified schemes. This allowed the classification algorithm to discriminate against non-aspen cover, providing the analyst opportunity to refine where necessary.

Despite various applications of remote sensing methods to reduce confusion within and between aspen stand classes, discriminating understory components remains difficult to address. In the light of rapid aspen mortality, the ability to identify regenerating stands has profound implications on management opportunity. However, the initial appearance of aspen regeneration and/or young conifer trees is often difficult or impossible to detect, much less decipher beneath the aspen canopy during both growing (overstory canopy) and winter seasons (snow cover and shadows). Multi-season imagery has been implemented to increase discriminatory power in pure aspen and aspen/conifer classes with moderate success (Heide, 2002; Lowry et al., 2007). However, the likelihood of obtaining specific-multiple dates of cloud free imagery and the potential for multi-modal training spectra (i.e., inherent effects of elevational gradients on phenology...
and snowcover) can result in intractable error in model algorithms.

This research supports the observations reported in the scientific literature and popular media that aspen is declining throughout the Intermountain West and that restoration decisions with respect to drought are important considerations in the management of aspen. Interpretable as a map of Cedar Mountain aspen stand types (Fig. 4-5), the classification and landscape assessment should be regarded as a spatially explicit, ecological health gradient resource with which management can utilize to locate, design, and prioritize management efforts for the Cedar Mountain area. Based on this analysis, approximately half the aspen cover for Cedar Mountain appears to be healthy (~50%) with large portions of aspen on the mountain regenerating sufficiently. However, a significant portion of the Cedar Mountain aspen cover (35.0 %) is affected by incidence of mortality. Large, old stands with minimal to no regeneration represent a significant portion of the mountain (Rogers et al., 2010). Considering the many site specific factors that might contribute to the decline of aspen on Cedar Mountain, such as old stands, poor stand structure, limited regeneration, grazing and browsing pressure on suckers, and drought conditions, many areas are expected to continue to degrade in the absence of appropriate and effective intervention.

Along with other areas in the Intermountain West that are experiencing rapid mortality of aspen, Cedar Mountain represents a spatially discrete ecotone of aspen’s overall distribution throughout the West, where rapid changes in aspen cover over time are expected (Brown, 1995). In targeting these areas, restoration efforts can optimize clonal expansion through disturbance via vegetative suckering. Sheppard et al. (2001) suggests a number of management techniques utilized for restoration of aspen stands,
such as mechanical root stimulation, selective commercial harvest, prescribed fire, competitive vegetation removal, and protection of aspen regeneration from ungulate use.

On Cedar Mountain, it is important to consider the historical management (160 years) before selecting a management application, as well the implications of biophysical settings for the landscape given the past decade of drought conditions. Broadly, Cedar Mountain managers should also consider additional questions to help direct restoration efforts. What are the long-term disturbance regimes for the area? If disturbance based restoration is implemented, what type of disturbance is being restored and what conditions are desired as an outcome? Given the fire suppression and grazing history of Cedar Mountain, would prescribed fires be effective? Should forest harvesting treatments be supplemented with understory seeding? Or, should the domestic and wildlife management practices for Cedar Mountain be evaluated more critically, given the present condition? Lastly, what would be the consequences of a no management action? Given that aspen on Cedar Mountain is regarded as a keystone species, the continued loss of aspen cover will assuredly result in compromised community structure and function at the landscape scale (Rumble et al., 2001).

Ecosystem management requires a broad understanding of the complex interactions between natural disturbance regimes, succession, and historical and future management action. Classification models, such as the one for Cedar Mountain, provide a spatially explicit resource for scientists, land owners, managers, and stakeholders to better evaluate potential management options, and to assist in the planning, implementation, and monitoring of aspen restorations projects. Despite its apparent merit, landscape models have inherent limitations, and should not be regarded as exact.
Rather, the ultimate merit should be whether this model leads to better decisions (Starfield, 1997).

**Conclusion**

The objectives of this project were to develop an approach and produce an aspen stand type land-cover map that meets the needs of land managers for Cedar Mountain. The model presented here indicates that 35.0% of the aspen cover on Cedar Mountain in southern Utah is currently damaged. Relative to healthy aspen stands, incidence of mortality was most frequent on southern aspects at lower elevations, suggesting drought may be related to the recent mortality. These results confirm field observations that aspen has declined over the past decade, and management intervention may be needed to prevent further loss of aspen from the Cedar Mountain landscape. This product can provide a spatially explicit resource for land managers and stakeholders toward more effective management of aspen.

**References**


Table 4-1. PRISM 2006 monthly and annual climatic data for Cedar Mountain, Utah (37.56248 N 113.0632 W) are given. Mean maximum (T_{max}) and minimum (T_{min}) temperature (°C) and precipitation (ppt; mm) for the period 1971-2000. The spatial resolution for this data set was 30 arc-seconds (approx. 800 m).

<table>
<thead>
<tr>
<th>Year</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>Apr</th>
<th>May</th>
<th>Jun</th>
<th>Jul</th>
<th>Aug</th>
<th>Sep</th>
<th>Oct</th>
<th>Nov</th>
<th>Dec</th>
<th>Annual</th>
</tr>
</thead>
<tbody>
<tr>
<td>T_{max}</td>
<td>-0.9</td>
<td>0.45</td>
<td>2.47</td>
<td>6.07</td>
<td>10.6</td>
<td>16.5</td>
<td>19.7</td>
<td>19</td>
<td>14.9</td>
<td>9.15</td>
<td>3.2</td>
<td>-0.4</td>
<td>19.7</td>
</tr>
<tr>
<td>T_{min}</td>
<td>-11</td>
<td>-11</td>
<td>-8.9</td>
<td>-6</td>
<td>-1.1</td>
<td>3.96</td>
<td>7.33</td>
<td>6.64</td>
<td>2.81</td>
<td>-2.2</td>
<td>-7.8</td>
<td>-11</td>
<td>-3.2</td>
</tr>
<tr>
<td>ppt</td>
<td>101</td>
<td>118</td>
<td>139</td>
<td>75.2</td>
<td>57.7</td>
<td>23.8</td>
<td>44.4</td>
<td>54.5</td>
<td>52</td>
<td>63.9</td>
<td>70.6</td>
<td>64.3</td>
<td>864</td>
</tr>
</tbody>
</table>

Table 4-2. The 13 predictor layers used in aspen CART classification model.

<table>
<thead>
<tr>
<th>Model Input</th>
<th>Band #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Landsat TM 5 refl.</td>
<td>Band 1</td>
<td>Blue</td>
</tr>
<tr>
<td>Landsat TM 5 refl.</td>
<td>Band 2</td>
<td>Green</td>
</tr>
<tr>
<td>Landsat TM 5 refl.</td>
<td>Band 3</td>
<td>Red</td>
</tr>
<tr>
<td>Landsat TM 5 refl.</td>
<td>Band 4</td>
<td>NIR</td>
</tr>
<tr>
<td>Landsat TM 5 refl.</td>
<td>Band 5</td>
<td>MIR</td>
</tr>
<tr>
<td>Landsat TM 5 refl.</td>
<td>Band 6</td>
<td>MIR</td>
</tr>
<tr>
<td>Core-image derivative</td>
<td>Band 7</td>
<td>Brightness</td>
</tr>
<tr>
<td>Core-image derivative</td>
<td>Band 8</td>
<td>Greenness</td>
</tr>
<tr>
<td>Core-image derivative</td>
<td>Band 9</td>
<td>Wetness</td>
</tr>
<tr>
<td>DEM</td>
<td>Band 10</td>
<td>Elevation</td>
</tr>
<tr>
<td>DEM</td>
<td>Band 11</td>
<td>Slope</td>
</tr>
<tr>
<td>DEM</td>
<td>Band 12</td>
<td>Aspect</td>
</tr>
<tr>
<td>Landform</td>
<td>Band 13</td>
<td>Landform</td>
</tr>
</tbody>
</table>
Table 4-3. Gradient of pixels, hectares, and percentage classified for each class.

<table>
<thead>
<tr>
<th>Aspen cover class</th>
<th># of pixels</th>
<th>Area (ha)</th>
<th>% aspen cover</th>
</tr>
</thead>
<tbody>
<tr>
<td>Healthy</td>
<td>66,230</td>
<td>5,960</td>
<td>49</td>
</tr>
<tr>
<td>Damaged</td>
<td>46,783</td>
<td>4,210</td>
<td>35</td>
</tr>
<tr>
<td>Seral</td>
<td>21,875</td>
<td>1,968</td>
<td>16</td>
</tr>
</tbody>
</table>

Table 4-4. Error matrix for Cedar Mountain aspen stand classification

<table>
<thead>
<tr>
<th>Reference Data</th>
<th>Healthy</th>
<th>Damaged</th>
<th>Seral</th>
<th>Totals</th>
<th>UA %</th>
<th>CE %</th>
</tr>
</thead>
<tbody>
<tr>
<td>Healthy</td>
<td>195</td>
<td>24</td>
<td>7</td>
<td>226</td>
<td>86.3</td>
<td>13.7</td>
</tr>
<tr>
<td>Damaged</td>
<td>28</td>
<td>120</td>
<td>7</td>
<td>155</td>
<td>77.4</td>
<td>22.6</td>
</tr>
<tr>
<td>Seral</td>
<td>11</td>
<td>6</td>
<td>47</td>
<td>64</td>
<td>73.4</td>
<td>26.6</td>
</tr>
<tr>
<td>Totals</td>
<td>234</td>
<td>150</td>
<td>61</td>
<td>362</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PA%</td>
<td>83.3</td>
<td>80.0</td>
<td>77.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EO%</td>
<td>16.7</td>
<td>20.0</td>
<td>23.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overall err.</td>
<td>83</td>
<td></td>
<td></td>
<td></td>
<td>81.3%</td>
<td></td>
</tr>
</tbody>
</table>

Note: UA, user's accuracy; PA, producer’s accuracy; EO, errors of omission, EC, errors of commission.

Table 4-5. P-values from Tukey-Kramer multiple comparisons tests for elevation, slope, and aspect against different aspen cover classes.

<table>
<thead>
<tr>
<th>Stand class</th>
<th>Elevation</th>
<th>Slope</th>
<th>Aspect</th>
</tr>
</thead>
<tbody>
<tr>
<td>Healthy vs. Damaged</td>
<td>0.02</td>
<td>0.96</td>
<td>0.02</td>
</tr>
<tr>
<td>Healthy vs. Seral</td>
<td>0.00</td>
<td>0.01</td>
<td>0.91</td>
</tr>
<tr>
<td>Damaged vs. Seral</td>
<td>0.04</td>
<td>0.01</td>
<td>0.04</td>
</tr>
</tbody>
</table>

Note: Significance (p < .05)
Figure 4-1. Study area located southeast of Cedar City, UT. Inset box indicates location of study area situated on the Kolob Terrace within the Markagunt Plateau.
Figure 4-2. Map of study area with training data systematically lain within aspen cover mask.
Figure 4-3. The 4 ancillary datasets (predictor layers) used in the model derived from 30-m DEM; Slope (in degrees), elevation, aspect (moisture index), and a 10-class landform dataset (Manis et al (2001)).
Figure 4-4. General mapping process for the aspen health classification.
Figure 4-5. Final aspen stand classification map containing three mapped classes for the Cedar Mountain study area in June 2008.
Figure 4-6. Elevation, slope, and aspect means (n = 122) for each aspen stand class on Cedar Mountain. Note: Different letters indicates significance (p = 0.05)
Quaking aspen is undoubtedly a valued ecosystem in the Intermountain West, providing commercial, biological, and aesthetic merit to a vastly diversified western landscape. However, over the past century, a myriad of environmental changes have rendered aspen susceptible to large, landscape level decline, with some areas experiencing complete loss of the aspen altogether. On Cedar Mountain in southern Utah, significant mortality of aspen has occurred in the past decade. To this end, the findings of this project are consistent with observations reported in recent literature and popular media that western aspen in the United States is declining in many areas and that restoration decisions are imperative to the management of aspen. The methodologies included use of a decision tree classifier (CART) to train moderate scale imagery, core-image derivatives, and ancillary datasets to effectively conduct a spatially explicit 2008 landscape assessment of aspen stand types and condition for Cedar Mountain in southern Utah.

Analysis revealed that 35% of the aspen cover on Cedar Mountain in southern Utah is currently damaged persistent stands, 49% was classified as healthy persistent stands (full overstory canopies), and 16% is considered seral or successional. Relative to healthy aspen stands, incidence of the damaged stands was most frequent on southern (drier) aspects at lower elevations, suggesting that water-related physiological stress may be linked to the recent mortality event. Considering the many site specific factors contributing to the decline of aspen on Cedar Mountain, such as old stands, poor stand structure, limited regeneration, high grazing and browsing pressure, and drought
conditions, many areas are expected to continue to decline in aspen cover in the absence of potential large-scale management intervention.

Interpretable as a map of Cedar Mountain aspen stand types, the classification and landscape assessment should be regarded as a spatially explicit, ecological health gradient resource that management can utilize to locate, design, and prioritize restoration efforts for the Cedar Mountain area. Ecosystem management at large requires a broad understanding of the complex interactions between natural disturbance regimes, succession, and historical and future management action. Classification models, such as the one for Cedar Mountain, provide a spatially explicit resource for scientists, land owners, managers, and stakeholders to better evaluate management needs and potential management options. Given their apparent merit, producing landscapes models have inherent limitations and should not be regarded as being without flaw. Rather, the ultimate merit should be whether use of this model leads to better information and decisions than otherwise.
APPENDICES

Appendix A
Predictor Layer Preparation

Core-image datasets

For Cedar Mountain, only one Landsat TM scene was needed to cover the study area. Landsat TM reflectance data (row 38, path 34) was acquired for June 26, 2008. The image was reprojected using the North American Datum 1983 UTM Zone 12N and nearest neighbor resampling intensity.

b) Select Landsat MRLC from first dropdown, then select the MRLC/MTBC reflectance option from the second dropdown. This imagery contains reflectance values that have been pre-processed for atmospheric corrections, and can be used without further radiometric enhancement.
c) Next, click the collection button, then select Landsat Archive and choose the Landsat 4-5 TM imagery option.
d) Locate study area by either entering coordinates or panning map with cursor. Scan imagery for clarity and cloud free dates during peak growing months (June – August) and select the best scenes.
e) Once imagery is selected, click the “add” button, followed by the “download” button. If not a registered member at this point, users will be asked to register. Click “Start Download.”
f) Download and save file(s) in a folder. After downloading, extract (unzip) files.
g) Open Erdas Imagine 9.1. In a viewer, open file(s) containing the imagery (select TIFF file type), and select the reflectance file (i.e._refl.tif)
h) Click the “DataPrep” button on the main toolbar in Erdas. Select Reproject images. Select Datum and projection for study area. Use 30 x 30 cell size and select the nearest neighbor resampling method.
- Repeat steps “g” and “h” for all predictor layers.
Image derived datasets

a) In the same file that Landsat TM data was stored and extracted, there are 3-4 other files that can be selected. One being the _tc.tif file, which is theBrightness, Greenness, and Wetness (BGW) index. Select and repeat steps g) and h).

DEM derived datasets

a) To acquire 30-m Digital Elevation Models (DEM) for the state of Utah, access the Utah GIS Portal http://agrc.its.state.ut.us/ website. Click GIS Data link on the upper tool bar. Next, select Download data for SGID → Elevation/Terrain → 10, 30, 90 DEM → 30m DEM → Statewide (zip) 30_m_DEM.zip and download. Extract files once downloaded.

b) In Erdas viewer, add the DEM dataset for study area. To create slope and aspect DEM derived datasets, select Interpreter from the main toolbar, then topographic analysis, and select either slope or aspect. Other datasets are also available to produce from the list.

c) Next, select the DEM file as the input file, then name and save the output file in a folder (i.e. predictor layers). In same box, select degrees or percent, then OK.

d) For ArcGIS, select ArcToolbox → Spatial Analyst → Surface → Aspect, Slope, etc.

e) Resample and reproject datasets following steps g and h in section 1.

Summary of predictor layers

a) Multi band predictors:
   1. Landsat TM 5 reflectance (bands 1-5 & 7 for Summer 2008)

b) Single band predictors:
   1. 2008 Summer Brightness
   2. 2008 Summer Greenness
   3. 2008 Summer Brightness
   4. Elevation - continuous (integer)
5. Aspect – continuous moisture index (integer)

6. Slope – continuous (integer)

7. Landform – categorical 9 class

**Acquisition and delineating aspen cover using NAIP imagery.**

a) For study sites in Utah, access available NAIP imagery from the Utah GIS Portal [http://agrc.its.state.ut.us/](http://agrc.its.state.ut.us/) website. Click GIS Data link on the upper tool bar. Next, select Aerial Imagery, then the year and type of aerial photography that meets project objectives. Download the selected imagery. This will bring up a list of available zip files. Select files that cover study area and place into a folder. Extract/unzip files.

b) Open ArcGIS 9.2. Click the “Add data” button and select the NAIP files. Determine appropriate projection. Pyramids may need to be constructed. (Note: Cedar Mountain was North American Datum 1983 UTM Zone 12N).

c) A shapefile needs to be created in order to begin digitizing. Select the ArcCatalog button. Find or create a folder. In folder, right click and select shapefile. Name shapefile (e.g. aspen mask). Select polygon as the feature type. Press Edit. To properly project the shapefile, select import and select a form of imagery that has previously been reprojected. Push OK. Push OK again. Close ArcCatalog.

d) In ArcMap, set the scale around the 1:6000 range for optimal resolution. This will depend on the quality and resolution of the imagery. Next, click the Add button and select the newly created shapefile (i.e. aspen mask).

e) To begin editing (digitizing), press the editor toolbar button → editor dropdown → start editing. In the pop-up box, select the aspen mask shapefile. In the Editor bar, make sure the Task is “create a new feature” and the target is the “aspen mask” shapefile. Push OK.

f) Next, in the Editor toolbar, click the pencil symbol and begin delineating (digitizing) all aspen cover from non-aspen cover.

**g)** Periodically, save your edits. To do this, in Editor toolbar, click the Editor dropdown and select “stop editing” and save. Continue until finished.

**h)** For modeling purposes, converting the delineated aspen mask .shp file to an .img file will be necessary. In ArcToolbox, select Conversion Tools → To Raster → Polygon to Raster. Select the aspen mask .shp file for input.
features, use Cell_Center for the cell assignment type, and select “30” for the cell size. All other specifications use default settings.

i) In order to properly apply the aspen mask, all the individual polygons that compose the shapefile need to be combined into one. Open Raster Calculator. Select aspen mask .img file, multiply by “0” and add “1”. The formula should be as follows: \([\text{aspen_mask}.\text{img}] \times 0 + 1\).

j) The Raster calculation will provide a temporary layer named “Calculation” in the layers column. This needs to be made permanent. Right click the temporary layer → Data → Export Data. This brings up the Export Raster Data box. In this box, make sure a 30 x 30 cell size is selected and the output file (format) is an IMAGINE Image. Name file and select output folder and select save. This file is now ready to be used as a mask in the modeling procedures.

**AOI and subsetting procedures**

All operations are conducted in Erdas Imagine 9.1.

a) Display imagery containing study area in viewer. Select file → new → AOI layer. Next, select AOI → Tools. A toolbox pops up. Utilize tools/options to create broad boundary of study area. (Note: Boundary will be used to subset all other predictor layers. The NAIP-based aspen delineation will be used specifically in the CART model to reduce non-aspen cover).

b) Once an AOI is established, save the AOI in a folder. Next, click the “DataPrep” button on the main toolbar and select subset image.

c) Choose the reprojected imagery (.img) files as your input file. Create an output file name and place in a convenient folder. Next, select the AOI button/box at the bottom. Choose viewer. Select OK.

d) Repeat procedure for all predictor layers used in the model.
Appendix B
Sampling

Sample point generation

a) A systematic grid can be established within the delineated aspen mask using Hawth’s Tool. Download and install Hawth’s Tools from [http://www.spataiyoecology.com/htools/](http://www.spataiyoecology.com/htools/). This free extension for ArcMap provides a suite of useful sampling tools, including a tool to create systematic grids of user specified size. Once Hawth’s Tools is installed, a new toolbar should appear in ArcMap. If it does not, check if extension is active (Tools → Extensions…) and make sure the toolbar is visible (View → Toolbars).

b) Determine the desired grid size (Note: Cedar Mountain application used a 900m grid). In Hawth’s tools, select Sampling Tools → Generate Regular Points. Select aspen mask layer for the extent. Specify point spacing. Select either alignment or alternating rows and the output shapefile and folder. Click OK.

c) Next, the points within the aspen mask need to be extracted. Press Selection → Select by location → grid generated → “are completely within” → aspen mask .shp file (Note: This file needs to be a vector file). Select Apply. This will select all points within the aspen mask.

d) These selected points need to be extracted. Right click the grid layer and select Data → Export Data. In the pop up box, make sure “selected features” is in export box, as well the coordinate system is the same as this layer, give the file a name and press OK.

e) Next, the points need coordinates for both modeling and field purposes (optional). In Hawth’s Tools, select Table Tools → Add XY to Table (points). In the pop-up box, select the grid file just produced, click the Add new fields tab and enter names for the X and Y field (e.g. “X Coord” and “Y Coord”). Select the same Coordinate System as the layer’s source data. Press OK.

f) Open the attribute table for the grid data layer and examine the data. Notice the ID column contains only zeros for all points. For identification purposes, start the Editor (this allows to edit data in the attribute table), right click the “ID” column and select Field Calculator. In the Fields box, select “FID”. This will add it to the ID = box. Once entered, add “ + 1” to “FID”. The command should read: [FID] + 1. This will assign an ID number to each sample point, starting with 1. Save edits and stop editing.
g) Optional: Verify selected sample points for pure and/or seral aspen cover classes with NAIP imagery. Cedar Mountain maintained a requirement of at least 75% pure and/or seral aspen cover for a 90 x 90m plot. (Note: Sample point was the center of plot).

*Sample point designation (cover classes)*

a) Each sample point ground-truthed was assigned to one of three aspen stand classes based primarily on crown and overstory. On Cedar Mountain, each site was assigned to a cover class based on the following criteria (Table A-1).

b) NAIP-based classification was implemented after initial model classification to increase sample points for certain classes. When using NAIP imagery for designation procedures, prior visitation of study area aids considerably in discriminating between different cover classes. Once photo interpreter is trained, deciphering the three aspen stand classes is straightforward (Figure A-1).

*Summary of samples*

a) 94 samples were visited on-site and designated during 2008. An additional 28 points were acquired and designated using NAIP imagery. 50 sample points were assigned to both “Healthy” and “Damaged” aspen stand classes, while 22 sampling points were assigned to the “Seral” aspen stand class, for a total of 122 sample points used in the final model.

b) 94 samples were visited on-site and designated during 2008. An additional 28 points were acquired and designated using NAIP imagery. 50 sample points were assigned to both “Healthy” and “Damaged” aspen stand classes, while 22 sampling points were assigned to the “Seral” aspen stand class, for a total of 122 sample points used in the final model.

c) Once all sample points are assigned a cover class, this file needs to be converted to a .txt file for use in the NLCD mapping tool. To do this, open the .dbf file for the sample points in an excel spreadsheet. Data contained should only consist of X and Y coordinates and cover class designation (see example). Thus, removing the site ID and column titles is necessary from the spreadsheet. Keep data only. Save as a .txt file. (Table A-2).
Table A-1. Criteria for the Cedar Mountain aspen stand cover classes.

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Healthy</td>
<td>Full crowns with little to no die-off (&lt; 25% overstory mortality)</td>
</tr>
<tr>
<td>Damaged</td>
<td>Consisted of dead and dying stands with considerable to full overstory die-off and/or foliage loss (25-100% overstory mortality)</td>
</tr>
<tr>
<td>Seral</td>
<td>Presence of aspen and at least 25% conifer cover within the plot</td>
</tr>
</tbody>
</table>

Note: Condition based on 90 x 90m plot observation.

Table A-2. Example of a portion of an excel spreadsheet used to convert sample point data into a .txt file. The first two columns are composed of coordinates and the third is the site stand type. This file is used as the dependant variable in the decision tree classifier.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>323017</td>
<td>4147207</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>319867</td>
<td>4149907</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>321667</td>
<td>4149907</td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td>326617</td>
<td>4150807</td>
<td>1</td>
</tr>
<tr>
<td>5</td>
<td>326167</td>
<td>4151707</td>
<td>1</td>
</tr>
<tr>
<td>6</td>
<td>328867</td>
<td>4151707</td>
<td>1</td>
</tr>
<tr>
<td>7</td>
<td>325717</td>
<td>4152607</td>
<td>1</td>
</tr>
<tr>
<td>8</td>
<td>321217</td>
<td>4154407</td>
<td>1</td>
</tr>
<tr>
<td>9</td>
<td>317167</td>
<td>4155307</td>
<td>1</td>
</tr>
<tr>
<td>10</td>
<td>318067</td>
<td>4155307</td>
<td>1</td>
</tr>
<tr>
<td>11</td>
<td>322531</td>
<td>4155314</td>
<td>1</td>
</tr>
<tr>
<td>12</td>
<td>325267</td>
<td>4155307</td>
<td>1</td>
</tr>
<tr>
<td>13</td>
<td>326167</td>
<td>4155307</td>
<td>1</td>
</tr>
<tr>
<td>14</td>
<td>316267</td>
<td>4157107</td>
<td>1</td>
</tr>
<tr>
<td>15</td>
<td>327967</td>
<td>4157107</td>
<td>1</td>
</tr>
<tr>
<td>16</td>
<td>315817</td>
<td>4158007</td>
<td>1</td>
</tr>
</tbody>
</table>
Figure A-1. Example of deciphering aspen health stand classes based on NAIP canopy characteristics.
Appendix C
Modeling

Introduction

To model aspen systems using these techniques, software and extension tools used in this application included ArcGIS 9.2, Erdas Imagine 9.1, See5 data mining software, and the NLCD (National Land-Cover Dataset) mapping tool (Homer et al., 2004). These tools were used in conjunction to conduct the Classification and Regression Tree (CART) analysis using the 13 selected predictor layers for the model.

Procedures

a) Download and install the NLCD mapping tool from www.mrlc.gov. This is an Erdas Imagine extension that interfaces with See5 data mining software to conduct Classification and Regression Tree Analyses.

b) In Erdas, open the NLCD mapping tool and select the NLCD mapping Tool. In the Independent Variables box, select all available predictor layers (i.e. Landsat TM data, elevation, landform, etc.) for the all potential models. These datasets should be all in one folder for ease of access (e.g. Predictor layers). For each model, select any combination of predictor layers and add them to the Independent File List. These datasets will be used to train this particular model.

c) In the Dependant Variable (.txt) box, select the sample point .txt file generated from the grid (Appendix B). Accept the 255 default value for the Ignore Values box. Under Sampling number, select percent. Enter 80% for training and 20% for validation. This ratio can be altered. Select “random” for sampling method. Name the output name file (.names file). Select See5. Press OK.

d) Open See5 data mining software. Select File → Locate Data. Browse files for data file produced by the NLCD mapping tool. This file should be in the same folder as the .names file.

e) Click the Classifier Construction Options (2nd button from the left). This provides many options to manipulate the decision tree. For the Cedar Mountain applications, Boost was selected and 15 trials were employed, and
the Global pruning box was unchecked. Experiment with the options.
Select OK when finished.

f) A results box from the decision tree will pop-up. The .test data (i.e. error matrices) is presented at the bottom. Examine the results for overall performance.

g) Next, in the NLCD mapping tool, choose the See5 Classifier button. Select the generated .names file (step c). Select tree and the .tree file will automatically be entered. Select the NAIP based aspen mask .img file (i.e. aspen_mask.img) for the mask option. Lastly, name the output file (.img) and select a folder to store it in (i.e. all model output files should be stored in this folder). Check the Create Error or Confidence Layer and select OK.

h) Open the output file (.img) in a new Erdas viewer to view the map of the generated model. Examine the map for general appearance and accuracy. Repeat steps b-h for each model until the best model is selected. Once a model is selected for the final product, repeat the modeling procedures using 100% of the data to train the model. Once produced, the next step is to employ an independent accuracy assessment using high resolution imagery (See Appendix D).

See5 file descriptions (Rulequest 2004)

a) .data file: Contains the training cases from which See5 extracts rules. This is also produced from the CART Module Sampling tool, by ‘drilling’ the dependent variable pixels through the specified predictor images. Required by See5 Software.

b) .test file: Produced from the CART Module Sampling tool, but not used by SWReGAP. This file, if populated, would contain a separate ‘test’ set of cases to evaluate the rules generated from See5. The SWReGAP mapping procedures did not populate this file, and it was not used.

c) .names.hst file: Produced from the CART Module Sampling tool. Details the distribution of samples available within the dependent input, and those output to the *.data and *.test file. Not required by See5, but produced by CART Module Sampling tool.

d) .set file: Produced from See5 software. This file contains the settings for the classification tree run. For example the third value ‘15’ indicates the number of boosts used for boosting.
e) .tree file: Produced from the See5 software. This file contains the classification tree in ‘tree’ format. This along with the *.data and *.names file are required by the CART Module Classifier tool to spatially apply the tree.

f) .out file: Output file generated by See5 and displayed when See5 classification tree model has run. This file provides a visual representation of the classification tree that is somewhat easier to interpret than the *.tree file.
Validation

Introduction

Two accuracy assessments were conducted during the modeling and validating procedures to examine model performance. The first accuracy assessment(s), described in Appendix C, were preliminary and were employed in the See5 data mining software (Classification Tree (CT)) during the modeling procedures. The CT model was run utilizing 80% of the reference samples while randomly selecting and withholding 20% of the reference points to validate the CT model. The validation works by intersecting the validation sample points with the CT modeled map to see if the generated map agrees with the validation points. The .txt, .dbf, and .shp files were examined for a kappa statistic, error matrices including commission and omission errors, and for spatial references to errors, respectively. This process was repeated until a final model was selected and ran using 100% of the reference data to train the model.

Discussed next, the final model was validated by a thorough independent accuracy assessment that utilized high resolution NAIP imagery as the reference source. High resolution (1m) NAIP imagery was selected since it is readily available, free of charge, and offers great spatial resolution with color infrared options, and can serve as a highly reliable surrogate for on-site ground truthing. In this application, a 500 m systematic grid (445 points) was established within the delineated aspen mask. Each of the generated reference points in the grid were designated into one of the three aspen stand classes, then compared against the final model (i.e. aspen stand classification map) to create standard error matrices and a Kappa statistic.
Validation procedures

Validation procedures are all conducted in ArcGIS 9.2.

a) If the Hawth’s Tool extension was not downloaded earlier, download and install from [http://www.spatialecology.com/htools/](http://www.spatialecology.com/htools/). Once Hawth’s Tools is installed, a new toolbar should appear in ArcMap. If it does not, check if extension is active (Tools → Extensions…) and make sure the toolbar is visible (View → Toolbars).

b) To create a systematic grid, repeat steps a – c in Appendix B under “Sample Point Generation”. (Note: For Cedar Mountain, a 500 m systematic grid was produced within the aspen mask shapefile) (Figure A-2).

c) Add study area NAIP images to viewer. Examine each grid point independently and remove sites that do not meet the criteria of at least 50% aspen cover. (Note: Grid layer needs to be in editing mode (Editor toolbar → Editor dropdown → Start Editing → Select source containing grid layer → Click OK)).

d) Once grid is established, re-examine each point and determine the aspen stand class based on NAIP imagery canopy characteristics (e.g. 1 - Healthy, 2 – Damaged, etc.). This process of classifying reference points needs to be done prior to validating the model. (Note: This procedure can simultaneously occur during step c). In order to classify each point, a new column needs to be added to the grid layer attribute table. Make sure grid layer is NOT in editing mode. Select the grid layer and open the attribute table. In the attribute box, select Options → Add Field → name the field (e.g. stand class or NAIP) and select “short integer” for the class → Click OK. Create a second column (e.g. ID) that will be used to monitor accuracy during the validation process (Table A-3).

e) Once all reference points have been classified, validation can begin. Add the modeled “aspen stand type” map layer, classified NAIP - based reference points, and NAIP imagery layers, and make sure they are active in the layer column on the left, with the NAIP imagery as the base layer.

f) Develop a labeling system to keep track of correct/incorrect validations (e.g. 1 = correct, 0 = incorrect). Begin validating by comparing the modeled map against the NAIP-based reference points. (Note: Having the NAIP imagery readily available is helpful during this phase) If the aspen layer correctly maps a given cover type, enter a “1” in the ID column for that reference point. Enter a “0” if it is incorrect. (See example). Repeat for each reference point.
g) Construct an error matrix (Table A-4) so that user and producer accuracy measures can be determined. Also, calculate the KHAT statistic (Congalton, 1991) based on the produced error matrix (Figure A-3). See Jensen (1996) for guidelines on constructing both error matrices and KHAT statistics.

Table A-3. Portion of the attribute table for NAIP validation points indicating the “ID” or map cover class and the NAIP based cover class.

<table>
<thead>
<tr>
<th>FID</th>
<th>Shape #</th>
<th>Id</th>
<th>NAIP</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Point</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>1</td>
<td>Point</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>Point</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>Point</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>Point</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>5</td>
<td>Point</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>6</td>
<td>Point</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>7</td>
<td>Point</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>8</td>
<td>Point</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>9</td>
<td>Point</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>10</td>
<td>Point</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>11</td>
<td>Point</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>12</td>
<td>Point</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>13</td>
<td>Point</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>14</td>
<td>Point</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>15</td>
<td>Point</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>16</td>
<td>Point</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>17</td>
<td>Point</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>18</td>
<td>Point</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>19</td>
<td>Point</td>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>
Table A-4. Error matrix for Cedar Mountain aspen stand classification.

<table>
<thead>
<tr>
<th></th>
<th>Reference Data</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Healthy</td>
<td>Damaged</td>
<td>Seral</td>
<td>Totals</td>
<td>UA%</td>
<td>CE %</td>
</tr>
<tr>
<td>Healthy</td>
<td>195</td>
<td>24</td>
<td>7</td>
<td>226</td>
<td>86.3</td>
<td>13.7</td>
</tr>
<tr>
<td>Damaged</td>
<td>28</td>
<td>120</td>
<td>7</td>
<td>155</td>
<td>77.4</td>
<td>22.6</td>
</tr>
<tr>
<td>Seral</td>
<td>11</td>
<td>6</td>
<td>47</td>
<td>64</td>
<td>73.4</td>
<td>26.6</td>
</tr>
<tr>
<td>Totals</td>
<td>234</td>
<td>150</td>
<td>61</td>
<td>362</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PA%</td>
<td>83.3</td>
<td>80.0</td>
<td>77.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EO%</td>
<td>16.7</td>
<td>20.0</td>
<td>23.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overall err.</td>
<td>83</td>
<td>18.7%</td>
<td></td>
<td>81.3%</td>
<td></td>
<td>69%</td>
</tr>
</tbody>
</table>

Note: UA, user’s accuracy; PA, producer’s accuracy; EO, errors of omission, EC, errors of commission.

Figure A-2. 500 m grid (446 points) generated in the delineated aspen mask used to validate the final aspen stand classification map for Cedar Mountain.
Figure A-3. NAIP imagery used during the validation process.

Figure A-4. Same NAIP image as the base layer with the aspen stand type map overlain. Comparing the model map and the NAIP imagery was the core procedure used to generate accuracy assessments for the Cedar Mountain application.
\[ \kappa^* = \frac{N \sum_{i=1}^{r} x_{ii} - \sum_{i=1}^{r} (x_{i+} \times x_{+i})}{N^2 - \sum_{i=1}^{r} (x_{i+} \times x_{+i})} \]

Figure A-5. KHAT statistic equation